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Introduction to Computer Applications

LECTURE SCHEDULE 1

Introduction to Computers, Anatomy of Computers, Input and Output Devices

In human affairs we have reached a point where the problems that we must solve are no longer

solvable without the aid of computers. | fear not computers but the lack of them.

ISAAC ASIMOV

Introduction to Computers

A computer can be defined as an electronic device capable of processing the data and

producing the information.

The computer system essentially comprises three important parts —

1. input device,

2. central processing unit (CPU) and

3. output device.

The CPU itself is made of three components namely,

1. arithmetic logic unit (ALU),
2. memory unit, and

3. control unit.

Components of a computer system

Central Processing Unit

Output Unit

Arithmetic
Logic Unit I
Input Unit
: P + ¢ Control Unit
Main
Memory
Secondary
Storage
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Introduction to Computer Applications

On broad basis, a computer performs the following tasks:

Input: Sending the data and command to the computer is known as input.

Processing: Work done by the computer with the help of processing hardware and software to

produce results is known as processing.

Output: The result displayed by the computer is known as output.

Storage: A place to save result inside or outside the computer is known as storage.

Anatomy of Computers

The following are the parts of a desktop computer.

Power Supply

When you plug your power cable into your computer,
you are actually plugging into a socket in the power
supply unit that has been fitted inside your case. This
component is responsible for converting the 240 volt AC

mains power to low voltage DC power needed by

computer components. The power supply generates
+3.3Vv, +5V, +12V, -5V. These voltages must be
constant, right up to the maximum current your system

will draw under load.

Monitor- Commonly known as a "screen," the monitor gives you a visual display of what your
computer is up to. Monitor displays are divided into pixels. The higher the pixel count, the higher
the "resolution.” Resolutions are measured in Rows x Columns. Common resolution settings are
640 x 480, 800 x 600, 1024 x 768, 1280 x 1024, etc.
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Introduction to Computer Applications

Mother board
The mainboard | which is sometimes called a motherboard. This
is usually the largest circuit-board in the computer, and every

other component in the computer connects to it.

Central Processing Unit An Intel CPU
The Central Processing Unit (CPU)is usually called either a CPU
or just a Processor. The CPU is the brain of the system. It
executes all the program code from the operating system and

the applications the user runs and processing of data. It sends

CPU commands to direct the actions of all the other components

in the computer.

Main Memory or Random Access Memory (RAM) RAM Chips
RAM, which stands for Random Access Memory, is the short '
term memory that the computer uses to keep track of what it's

doing. If the computer loses power, anything stored in RAM is

lost.

7 www.AgriMoon.Com


http://hubpages.com/slide/The-anatomy-of-a-computer/1387762�
http://hubpages.com/slide/The-anatomy-of-a-computer/1387786�

Introduction to Computer Applications

Storage Device A Hard Drive
Computer storage device is any type of hardware that
stores data. The most common type of storage device,

which nearly all computers have, is a hard drive.

INPUT AND OUTPUT DEVICES

Input Devices

Input device is a hardware device that sends information to the computer.

Mouse

Mouse is a pointer device.The
mouse allows an individual to
control a pointer in a graphical user
interface (GUI). Utilizing a mouse a
user has the ability to perform
various functions such as opening a

program or file and does not require

the user to memorize commands.

Digital camera

A type of camera that stores the
pictures or video it takes in

electronic format instead of to film.
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Web Cam

A camera connected to a computer

B
l

that allows anyone connected to the
Internet to view still pictures or

motion video of a user.

Joystick
A computer joystick allows an

individual to easily navigate an
object in a game such as navigating

a plane in a flight simulator.

Keyboard
One of the main input devices used

on a computer, a computer
keyboard looks very similar to the
keyboards of electric typewriters,
with some additional keys.

Microphone
Sometimes abbreviated as mic, a

microphone is a hardware
peripheral that allows computer
users to input audio into their

computers.
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Introduction to Computer Applications

Scanner
Input device that allows a user to

take an image and/or text and

convert it into a digital file, allowing
the computer to read and/or display
the scanned object

Output Device

Any peripheral that receives and/or displays output from a computer. Below are some examples
of different types of output devices commonly found on a computer.

Monitor

A monitor is a video display screen. Monitor is also called as Visual Display Unit (VDU) or Video
Display Terminal (VDT).

CRT (Cathode Ray Tube) Monitors are built LCD (Liguid Crystal Display) Monitors are

very similarly to older (tube) television sets. thin and flat. They are light, compact, take up
They are heavy, bulky, take up a lot of desk very little desk space emit no known radiation.

space, and emit radiation.
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Printer
A printer is an output device responsible for
taking computer data and generating a hard

copy of that data.

Speakers
Projector

11 www.AgriMoon.Com



Introduction to Computer Applications

LECTURE SCHEDULE 2

Units of Memory, Hardware, Software and Classification of Computers

Units of Memory

The memory unit is the principal storage of the computer. All the data and instructions that the
computer needs at a moment are stored here. All storage devices are characterized with the
following features:

Speed

Volatility

Access method

Portability

a > wn P

Cost and capacity

Linking Memory with the other units

Memory

Input ::> Processor :> Output

Storage

Basic Units of Measurement

The components of the computer can recognize only two states that is presence or absence of
an electrical signal. Two symbols used to represent these two states are 0 and 1, and are
known as BITS (an abbreviation for Blnary DigiTS). O represents the absence of a signal, 1
represents the presence of a signal. A BIT is, therefore, the smallest unit of data in a computer

and can either store a 0 or 1.
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Introduction to Computer Applications

Since a single bit can store only one of the two values, there can possibly be only four unique
combinations:

00011011
Bits are, therefore, combined together into larger units in order to hold greater range of values.
BYTES are typically a sequence of eight bits put together to create a single computer
alphabetical or numerical character. More often referred to in larger multiples, bytes may appear
as Kilobytes (1,024 bytes), Megabytes (1,048,576 bytes), GigaBytes (1,073,741,824),
TeraBytes (approx. 1,099,511,000,000 bytes), or PetaBytes (approx. 1,125,899,900,000,000
bytes).

Bytes are used to quantify the amount of data digitally stored (on disks, tapes) or transmitted

(over the internet), and are also used to measure the memory and document size.

Types of memory

Computers use several different types of memory. They are:
1. Main Memory / Primary Memory units
— Two most important are
*  RAM (Random Access Memory)
* ROM (Read-only Memory)
— They work in different ways and perform distinct functions
— CPU Registers
— Cache Memory
2. Secondary Memory/Auxiliary Memory
Also termed as ‘auxiliary’ or ‘backup’ storage, it is typically used as a supplement
to main storage. It is much cheaper than the main storage and stores large amount of
data and instructions permanently. Hardware devices like magnetic tapes, Floppy Disk,
Hard Disk, Optical disks, Compact Disk (CD), Digital Versatile Disk (DVD) and Blu-ray
Disc (BD) fall under this category.

Computer’'s memory can be classified into two types — RAM and ROM.

RAM or Random Access Memory is the central storage unit in a computer system. It is the

place in a computer where the operating system, application programs and the data in current
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use are kept temporarily so that they can be accessed by the computer’s processor. The more

RAM a computer has, the more data a computer can manipulate.

Random access memory, also called the Read/Write memory, is the temporary memory of a
computer. It is said to be ‘volatile’ since its contents are accessible only as long as the computer

is on. The contents of RAM are cleared once the computer is turned off.

ROM or Read Only Memory is a special type of memory which can only be read and contents of
which are not lost even when the computer is switched off. It typically contains manufacturer’'s
instructions. Among other things, ROM also stores an initial program called the ‘bootstrap

loader’ whose function is to start the computer software operating, once the power is turned on.

Hardware
Hardware, in the computer world, refers to the physical components that make up a computer
system. There are many, many different kinds of hardware that can be installed inside and
connected to the outside of a computer. However, there are several standard pieces of
hardware that can be found as part of nearly every computer:

* Input Devices - Key board, Mouse..

e CPU - (Brain) Named on model: 80286, 80386, 80486, Pentium, P-1l, Core 2 Duo..

e Output Devices - VDU/Screen, Printer

* Memory - RAM - Active, temporary ROM - Permanent.

» Ancillary Storage devices: Floppy, Hard Disk, CD ROM, Tapes etc.

e Scanner, Modem, Digital Camera, Video adopter, Computer Projector, Slide maker, etc.
Software

Software is a general term for the various kinds of programs used to operate computers and

related devices. Software is classified as follows:
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Software

System
Software

System software

Application
Software

System software refers to the operating system and all utility programs that manage computer

resources at a low level. Operating system controls and manages the computing resources.

Examples of operating system: Windows, Unix, MSDOS, Linux, Mac.

Systems software includes compilers, loaders, linkers, and debuggers.

LINUX

A

THE INTERNET'S
OPERATING SYSTEM

Mac

Applications software comprises programs designed for an end user, such as word processors,

database systems, and spreadsheet programs. Application software makes computer popular

and easy to use. Common application software:

Microsoft Word, WordPerfect
PowerPoint

Netscape, Internet Explorer
PhotoShop, Photo-Paint
Quick Time

Dreamweave

15
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Classification of Computers

Computers are available in different shapes, sizes and weights, due to these different shapes
and sizes they perform different sorts of jobs from one another. They can also be classified in
different ways. All the computers are designed by the qualified computer architectures that

design these machines as their requirements.
A computer that is used in a home differs in size and shape from the computer being used in a
hospital. Computers act as a server in large buildings, while the computer also differs in size

and shape performing its job as a weather forecaster.

A student carrying a laptop with him to his college is different in shape and size from all the
computers mentioned above. Computers are classified as follows:

Super computer

The biggest in size, the most expensive in price than any other is
classified and known as super computer. It can process trillions of
instructions in seconds. Governments specially use this type of
computer for their different calculations and heavy jobs. Different

industries also use this huge computer for designing their

products. In most of the Hollywood's movies it is used for
animation purposes. This kind of computer is also helpful for

forecasting weather reports worldwide.
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Mainframes

Another giant in computers after the super computer is
Mainframe, which can also process millions of instruction per
second and capable of accessing billions of data. This computer is
commonly used in big hospitals, air line reservations companies,
and many other huge companies prefer mainframe because of its
capability of retrieving data on a huge basis.

Minicomputer
This computer is next in the line but less offers less than

mainframe in work and performance. These are the computers,
which are mostly preferred by the small type of business

personals, colleges, etc.

Personal computers

Personal computer is the computer mostly preferred by the home

users. These computers are lesser in cost than the computers

given above and also, small in size; they are also called PCs in

short for Personal computers. This computer is small in size.

)
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Today this is thought to be the most popular computer in all.

Notebook computers

Having a small size and low weight the notebook is easy to carry
to anywhere. A student can take it with him/her to his/her school in
his/her bag with his/her book. This is easy to carry around and
preferred by students and business people to meet their
assignments and other necessary tasks. The approach of this

computer is also the same as the Personal computer. It can store

the same amount of data and having a memory of the same size

as that of a personal computer.
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LECTURE SCHEDULE 3

Personal Computers, Types of Processors, Booting of Computer- warm and cold

booting

Personal Computer

A personal computer (PC) is any general-purpose computer whose size, capabilities, and
original sales price make it useful for individuals, and which is intended to be operated directly

by an end user, with no intervening computer operator.

This is in contrast to the batch processing or time-sharing models which allowed large
expensive mainframe systems to be used by many people, usually at the same time, or large

data processing systems which required a full-time staff to operate efficiently.

A personal computer may be a desktop computer, a laptop, tablet PC or a handheld PC (also
called palmtop). Software applications for personal computers include word processing,
spreadsheets, databases, Web browsers and e-mail clients, games, and myriad personal
productivity and special-purpose software. Modern personal computers often have high-speed
or dial-up connections to the Internet, allowing access to the World Wide Web and a wide range

of other resources.

A PC may be used at home, or may be found in an office. Personal computers can be

connected to a local area network (LAN) either by a cable or wirelessly.
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While early PC owners usually had to write their own programs to do anything useful with the
machines, today's users have access to a wide range of commercial and non-commercial
software which is provided in ready-to-run form. Since the 1980s, Microsoft and Intel have

dominated much of the personal computer market with the Wintel platform.

The capabilities of the personal computer have changed greatly since the introduction of
electronic computers. By the early 1970s, people in academic or research institutions had the
opportunity for single-person use of a computer system in interactive mode for extended
durations, although these systems would still have been too expensive to be owned by a single
person. The introduction of the microprocessor, a single chip with all the circuitry that formerly

occupied large cabinets, led to the proliferation of personal computers after 1975.

Types of Processors

The Central Processing Unit (CPU) or the processor is the portion of a computer system that
carries out the instructions of a computer program, and is the primary element carrying out the

computer's functions.

Basically there are two types of processors which are manufactured by two companies and they

are Intel and AMD. Now there are a number of varieties available in both Intel and AMD.

Intel offers Pentium Pro, Pentium Il, Celeron, Pentium Il Xeon, Pentium IlI, Pentium Il and Il
Xeon, Celeron with Pentium |l Based, Pentium 4, Pentium M, Intel Core, Dual Core Xeon LV,
Intel Pentium Dual Core, Intel Core 2, Pentium Duo, Pentium Dual Core, Core 2 Quad, Intel

Pentium 2 Dual Core Processor.

AMD processors include AMD Athlon, AMD Athlon 64, AMD Athlon X2, AMD Athlon Xp, AMD
Duron, AMD Sempron, AMD Turion, MD Opteron and AMD Phenom 1.

Moreover, there are various processors offered by various companies like Macintosh processor.

In other words different processors are used for different types of technology.

Booting of Computer — Warm and Cold Booting

Booting of computer is the process of powering it on and starting the operating system. Booting

loads the first piece of software that starts a computer. Because the operating system is
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essential for running all other programs, it is usually the first piece of software loaded during the

boot process.

Cold boot is the process of starting a computer from a powered-down, or off state. Cold boot

is also called as hard boot.

Warm boot refers to restarting a computer that is already turned on via the operating system.
Restarting it returns the computer to its initial state. A warm boot is sometimes necessary when
a program encounters an error from which it cannot recover. On PCs, you can perform a warm
boot by pressing the Control, Alt, and Delete keys simultaneously. On Macs, you can perform a

warm boot by pressing the Restart button.
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LECTURE SCHEDULE 4

Computer Viruses, Worms and Vaccines

Computer Viruses

Computer virus is a small software program that is designed to spread from one computer to

another and to interfere with computer operation. A true virus is capable of self replication on a

machine. Virus may spread between files or disks.

There are estimated 30,000 computer viruses in existence.

Over 300 new ones are created each month.

First virus was created to show loopholes in software.
Today almost 87% of all viruses are spread through the internet.

Symptoms of Virus Attack

Computer runs slower than usual
Computer no longer boots up

Screen sometimes flicker

Speaker beeps periodically

System crashes for no reason
Files/directories sometimes disappear

Denial of Service (DoS)

Types Computer Viruses

Trojan Horse
* Requires Windows to work

* Once infected, runs in the background
Worm

» Spread over network connection

* Worms replicate
Macro

» Specific to certain applications

» Comprise a high percentage of the viruses

E-mail viruses

21
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* An e-mail virus travels as an attachment to e-mail messages, and usually
replicates itself by automatically mailing itself to dozens of people in the victim's
e-mail address book.

* Some e-mail viruses don't even require a double-click -- they launch when you

view the infected message in the preview pane of your e-mail software.
Worms

A worm is a small piece of software that uses computer networks and security holes to replicate
itself. A copy of the worm scans the network for another machine that has a specific security
hole. It copies itself to the new machine using the security hole, and then starts replicating from
there, as well.

Worms use computer time and network bandwidth when they replicate. A worm called Code
Red made huge headlines in 2001. Experts predicted that this worm could clog the Internet so

effectively that things would completely grind to a halt.

A worm usually exploits some sort of security hole in a piece of software or the operating
system. For example, the Slammer worm (which caused mayhem in January 2003) exploited a

hole in Microsoft's SQL server.

Worms normally move around and infect other machines through computer networks. Using a
network, a worm can expand from a single copy incredibly quickly. The Code Red worm

replicated itself more than 250,000 times in approximately nine hours on July 19, 2001.
Protect computer against viruses:

* Gain knowledge about viruses
* Proper configurations
* Run only necessary programs

» Install Anti-virus software and update
Vaccines
Vaccines or Antivirus software is a computer program that detects, prevents, and takes action to

disarm or remove malicious software programs, such as viruses and worms. New viruses,

worms, and other threats are created by cyber terrorists and discovered every day. So updating
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antivirus software is periodically mandatory. List of some top Anti Virus Programs which are

very useful to users:

Norton AntiVirus — Norton AntiVirus is the

most popular and secure virus scanner for
checking boot sector records at startup.
The live update feature automatically , Smlﬂntf?ﬂ. Confidence in a connected world.
installs new updates for regular protection

against viruses.

AVG Free Edition — AVG Resident Shield provides real-time protection
executions of files and programs. It features a smart e-mail scanner, j AVG
virus updates and virus vault for secure handling of the files which are ’

infected by viruses. The base version for windows is Free for private and

non-commercial use.

McAfee VirusScan for Windows: This antivirus package detects all @MCAfee'
virus types, including Word and Excel macros; boot-sector infections;

and file, multipartite, stealth, polymorphic, and encrypted viruses.

Kaspersky Anti-Virus Personal Pro — It is a commonly used

virus protection solution offering full protection against macro-

viruses and unknown viruses.

ESET NOD32 Antivirus — ESET NOD32 Anti-virus is available as

an anti-virus for small businesses, individuals and for large

networks.

avast! Home Edition — A free antivirus solution for scanning disk,
CDs, and E-mail.
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Panda Antivirus Platinum — It is a complete virus protection PANDA

package for home and business users. It comes with an easy S ECURITY

installation and automatic protection from latest viruses.
Avira - Windows and Linux anti virus, firewall, anti spam, recovery

solutions against malware infection

AVIRA
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LECTURE SCHEDULE 5

Operating System — Some Fundamental DOS Commands,Rules for naming files in
DOS and Types of files

Operating System

Operating system is a set of software that controls and manages hardware and basic system
operations for a computer. The operating system loads programs into the computer's memory,

runs these programs, and manages peripherals like disks and printers.

- -

LINUX

Example:

Disk Operating System (DOS)

Mac

Mac
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UNIX

Disk Operating System (DOS)

UNIX™

e In the 1980s or early 1990s, the operating system that shipped with most PCs was a
version of the Disk Operating System (DOS) created by Microsoft: MS-DOS.

e MS-DOS is a disk-based, single-user, single-task and character based user interface

(CUI) operating system.

Goto MSDOS from Windows Operating System:

Click Start Button > Choose Program -> Choose Accessories > Click Command Prompt as

shown below:

Sek Program Access and Defaults
Windows Catalog

Wwindows Update

Programs
Docurnents
Settings

Search

Help and Support

Run...

Log OFF Administrator. ..

Windows XP Professional

Turn OFF Carmputer. ..

=8

[@ Ankivir PersonalEdition Classic

[@ CyberLink PowerDVD

[@ Fames

@ Lavasoft Ad-Aware SE Personal

@ Microsoft Office

@ Mozilla Firefox

@ Mero

|7 Penta4CETs

[@ PrintMe Internet Prinkting

@ Startup

I7) wWinRAR

[} Acrobat Distiler 6.0

& Adobe Acrobat 6,0 Professional

@ Adobe ImageReady 7.0

E Adobe Phoktoshop 7.0

E® adobe Reader &

g Internet Explorer

MSH

outlook Express

' Remoke Assistance
windowes Media Plaver

windows Messenger

2E ras . .
23 M5 ﬁ Windows Maovie Maker

¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ v v v

@

s
s
s

w
=]
)
W
@

=
2
v}
&

Accessibility
Communications
Entertainment
Swstem Tools
Address Book
Calculakor
Command Prompk
Motepad

Faink

Program Compatibility Wizard
Svynchronize

Tour Windows <P
windows Explorer
‘“WordPad

Or Click Start Button &> Choose Run = Type cmd in the Open tab as shown below:
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- Twpe the name of a program, Folder, docurmenk, or
Internek resource, and Windows will open it Faor wou,

Cpen: b

| ] 4 | | Cancel | | EBrowse, ..

Command Prompt will get displayed as shown:

#

BEX Command Prompt |E|E|i"]

Microzoft Windows XP [Version 5.1.268@1
(G Copyright 1985-20E1 Microsoft Corp.

C:“Documents and Settings-Administrator’

The DOS commands can be entered in the command prompt and executed.

27
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Some Examples of DOS commands
DIR Command

The dir command allows you to see the available files in the current and/or parent directories.

Examples:
1. DIR
Lists all files and directories in the directory that you are currently in.
Bl Command Prompt |ﬂ|&]
[)
1 G G
. 0 0
G5/30/0010 04:59 BN <DIR '
1Y B 7 i H 0
i Y, HE H DI H
5 A @8:18 & DI F PG
5 1@ B4 : DIR ; i
A AR? @6 : DIR
A4 :, 794 0 [ HH 1
i HAY K E P [}
5 1@ B8:18 DIR i
[ H.86 04
-
2. dirjw

If information on the date / time and other information on the files are not
needed, then this command can be used to list just the files and directories going

horizontally, taking as little as space needed.
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Bl Command Prompt |ﬂ|&]

C:~>DIRAY
Uolume in drive C has no label.
Uolume Serdial Humber iz 4612-FCRA

| Directory of G:in

autoexec .bhat [classex] config.sys [jdk1.31 [Program Files]
[Python251 [TC] Turboc .exe [Uzers1] [Windows 1

3 Filedls> 4,.377.434 hytes

7 Dirds> 38.862.262.272 hytes free

3. dir/on

List the files in alphabetical order by the names of the files.

BX Command Prompt |ﬂ|i‘]

C:~>DIR ~ON
Uolume in deive C has no label.
Uolume Serial Humber is 4612-FC6A

Directory of C:o

886 B2:43 24 autoexec.bat

@18 B4:59 <DIR> classex

886 B2:43 18 config.sys

#@? ©B6:10 <DIR> Jdki_3

Ai@ ©B8:-18 <DIR> Program Files
@4:55 <DIR> Python25

B6:=31 <DIR> IC
a7:-22 4,.377.488 Turboc.exe
a7:-28 <DIR> Uzers
Bg:-18 <DIR> Windows
3 File<s) 4,.377.434 hytes
? Dir<s> 38.860.595.2008 bytesz free

4. dir /o-n

List the files in reverse alphabetical order by the names of the files.
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EX Command Prompt |ﬂlﬁ

= =
oy Oy
o= &
il
=R

= 5

=R
= =
=Rl =
A al

EEEEEEEDE DR

= 5 =
alun BBy
=

o e O

FORMAT Command

FORMAT command is used to erase all information of a diskette or fixed drive.
1. format a:

Would erase all the contents off a disk. Commonly used on a diskette that has not been

formatted or on a diskette you wish to erase.
2. formata: /q

Quickly erases all the contents of a floppy diskette. Commonly used to quickly erase all

information on the diskette.
3. format c:

This would erase all the contents of C: hard disk drive. In other words, unless you wish
to erase all your computer's information, this command should not be done unless you're

planning to start over.
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COPY Command

COPY command allows to copy one or more files to an alternate location.

Examples:

1. copy**a:

Copy all files in the current directory to the a disk drive.

2. copy filel.txt file2.txt

Copy the contents of filel.txt to file2.txt

3. copy myfilel.txt+myfile2.txt

Copy the contents in myfile2.txt and combines it with the contents in myfile1.txt.

PATH Command

Path is used to specify the location where MS-DOS looks when using a command. For example,
when using the command "format”, if the path is not specified to where the command is you will

receive bad command or file name.
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Example:

| = | B |- |

B C\Windows\system32\cmd.exe

C:~>PATH
PATH=C:*UWindows~systemd2 ;C:“Windows ;:C:~MNindows Systen3d2-Wben; C:“Program Files“Mi

crosoft SQL Servers8@-Tools-BIHN
RN

LABEL Command

Label is used to view or change the label of the computer disk drives.

Example:

label a: mydisk

This would label the disk currently in the drive to "mydisk", but will not label if your disk is

write protected.

VOL Command

VOL command displays the volume information about the designated drive.
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B Ch\Windowshsystem32omd.exe |ﬂ|i"]

G~ >U0L
Uolume in drive C haz no lahel.
Uolume Serial Humber iz 4612-FCbA

(R

MD (Make Directory) Command

MD command allows to create directories in MS-DOS.
Examples:
1. md test
Creates the "test" directory in the directory in the currently directory.

2. md c:\test

Creates the "test" directory in the c:\ directory.

CD (Change Directory) Command

CD (Change Directory) is a command used to switch directories in MS-DOS.
Examples:

1. cd\
Goes to the highest level, the root of the drive.
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BN C\Windows\system32\cmd.exe |ﬂ|&]

G STCSBINZCDS

G

2. cd.
Goes back one directory.
BN C:\Windows\system32\cmd.exe LEIEI&J

34 www.AgriMoon.Com



Introduction to Computer Applications

3. cd

Typing cd alone will print the working directory.

B Ch\Windows\systern32omd.exs |ﬂlﬁ

DEL Command

DEL command is used to delete files from the computer. Deleting files from MS-DOS does not

send files to the recycle bin.

Examples:

1. deltest.tmp

Deletes the test.tmp in the directory that you currently are in, if the file exists.

2. del c:\windows\test.tmp

Delete the c:\windows\test.tmp in the windows directory if it exists.

Rules for naming files in DOS

1. The combination of the following characters can be used for writing names of directories and

files:
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Alphabets A to Z (both capital and small).
Digits 0 to 9.
Special characters like spaces ' A0 $o & # @ % '-{}[]+-=-- .
Some special characters which cannot be used are? /\: 1<> Il *,
There are some words specifically reserved for special files and are not allowed if used
singly. They are CON, COM1, COM2, COM3. COM4, AVX, LPT1, LPT2, LPT3, PRN, NUL.
These words can be used in combination such as ASCon, deltacoml, Panamavx. etc.

4. Files with extension names like .EXE, .COM and .BAT are called executable files and are
given a special status by DOS.

5. Dot (.) is allowed only once.

Types of files in DOS

DOS supports a wide variety of files. The type of the file can be identified with the extension of
the file in the filename. The three letters following the name of the file is called as the extension
of the file.

Examples:

.bak

Used by programs and users to make a copy of an existing file for safety and/or archive
purposes.

.bas

A basic computer-language program file.

.bat
This is used for a batch file. Such a file is a series of commands in mostly plain english
which perform an operation in DOS automatically. They come with some programs and
may also be written by a user to make shortcuts or perform operations like sorting or
backups.
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.bin
A binary file.

A file of programming language in the C format.

.dat
Used to hold information about a particular aspect of a program or about a particular
operation. The latter may update a .dat file to reflect recent changes. Other operations in

the program may then view this file and other .dat files while determining a course of

action.
.db or .dbf

These are used by data base programs to hold the users' data information. Other
programs may use them to hold information used by the application itself for such things

as printer specifications regarding printer selection by the user.

dir
Used to house a directory list, especially for communications programs.

.exe
An executable file.

References

1. http://www.chebucto.ns.ca/~ak621/DOS/DOS-Ext.html

2. http://www.computerhope.com/msdos.htm
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LECTURE SCHEDULE 6

WINDOWS: GUI, Desktop and its elements, Windows Explorer, Working with files

and folders, Setting time and date, Starting and Shutting down Windows

WINDOWS

e An operating system with a graphical user interface (GUI).
e Graphical User Interface (GUI) is a user interface based on graphics (icons and pictures

and menus) instead of text; uses a mouse as well as a keyboard as an input device)

Versions

*  Windows 98

* Windows Me

*  Windows NT

* Windows 2000

*  Windows XP

* Windows Server 2003
* Windows Vista

*  Windows 7

Desktop and its elements

* In Windows operating system the basic working platform is the desktop.

» ltis also the opening screen of the Windows operating system.
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L S ek i s e Y

* The desktop contains:
— Taskbar

— lcons

Taskbar

» Taskbar is usually a narrow strip present at the bottom of the screen.

WINDOWS Xp Taskbar
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L]

representing

L 8

Quuck ST
duick applications

Launch
Toolbar

Start o Tagkbar

currentlv in

Tistat. O7° 8% [)cweesnc, T Conut b O

Windows Vista Taskbar

Start Button
Quick Launch Toolbar

Buttons representing the applications currently in use

System Tray

OFLOE "5 st/ Altenet%.,

T, B G Ve,

§ COMEO Nac, Vewtfen, <R UG

» Icons are small pictures/images representing applications.

» Eachicon has a label telling the name of the application it represents.

Example:

Computer . .
» lists the contents of floppy disk, hard disk, CD-ROM '

drive, and mapped network drives Computer
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Network "
» locates shared resources on the entire network to which -
the computer is connected. Netwaork
Recycle Bin =
b
» stores deleted files, folders, graphics, and Web pages k.

until you empty the bin.

Internet Explorer

» opens the browser internet explorer.

Windows Explorer

Windows Explorer is a file manager application used to view and manage drives, folders, and
files. Windows Explorer can be opened by clicking on
Start > My Computer or using the short cut key Windows + E while in Windows Xp

Start > Computer or using the short cut key Windows + E while in Windows Vista.

r @B 5 PN - P YT TR wv ™ L= | =) |

OOv % » Computer » . - | 4 |‘

‘ Organize ¥ Q= Views ~ g System properties gl Uninstall or change a program

Search F |

&="Map network drive >
Earnatelinks MName Type ‘ Total Size Free Space
E Da— Hard Disk Drives (4)

E;h Music Local Disk (C:) Local Disk (D:)
T ee—— 0 | == |
& Recently Changed 28.7 GB free of 63.4 GB C';::l/ 63.3 GB free of 63.4 GB

More » Local Disk (E:) Local Disk (F:)

o - | o
Folders v | & 502 B frec of 624 GE S 230 GB frec 0224 GB

Bl Desktop * | Devices with Removable Storage (1)

IR srioevt 4 DVDRW Drive (G)
.. Public - 6 ilamuruguk

18 Computer ——
&, Local Disk (C) |
a Local Disk (D:) |
—a Local Disk (E:)
—a Local Disk (F)
&% DVD RW Drive

L Network

Control Panel

% Recycle Bin
| AIT203
. CDAC

. COML01 QP200<
CORMINT Annlier

SRIDEVY Workgroup: WORKGROUP Memory: 249 GB
SRIDEVY ILAMURUGU  Processor: Genuine Intel(R) CPU
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Working with files and folders

Folders are the basic organizational building blocks of any computer system. Without folders it
would be virtually impossible to keep track of all the files that are found on even the smallest
system. New folders can be created just about anywhere, but three methods are shown below.

To create a folder

New Folder On Desktop - Right click anywhere on an open area of the desktop. Select New
and then click Folder. A new folder with the default name New Folder will be created on the
desktop. Either accept the default name New Folder (bad idea) by hitting the enter key or type a

new name for the folder (good idea) and then hit enter on the keyboard.

®  Shorkout

ﬁ Briefrase
3

@, Bitrnap Image
Wiordpad Document

Arrange Icons By
Refresh

Paste
Paste Shorbcuk E] Text Document
Undao Delete Chel+Z gﬂ wWave Sound

Y ] Compressed (zipped) Folder

Properties

\ew Folder
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To open afolder ’

e double click the folder with mouse

or QA Open

e right click the folder and click open Explore

tab from the right context menu. search...
Open as Motebook in OneMote
Add to Winamp's Bookmark list

Enqueue in Winamp

Play in Winamp
To Rename a folder E:j
 Locate and select the folder to be
renamed. Open
) ) Explore
* Right click the folder Search
 Select rename from the popup A Scan with AWG Anki-Spyware
menu ? Shred File

Sharing and Security. ..
E add ko archive. ..
E add ko "software. rar”
E Compress and email. ..
E Compress to "software.rar" and email

C3l WinZip
fed Scan selected Files with Ankivie

Send To

_uk

Copy
Faste

Create Shorkcout
Delske

Fenarmes

Froperties
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To Copy and Paste a folder

Locate and select the folder you
want to copy.

Choose copy

Choose the Destination location to
copy the folder

Choose paste

Create Shoru
Dt
Rename

Properts
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To delete a folder

» Locate and select the folder you want to delete.

* Choose delete.

Open
Explore
Search...

Open as MNotebook in OneMote

Share...

Add to archive...

Add to "MAARM.rar"
Compress and email...

Compress to "NAARM.rar" and email

il i i i

Groowve Folder Synchronization »

Restore previous versions

N

Scan selected files with AntiVir

Send To ]
Cut

Copy

Create Shortcut
Delete

Rename

Properties
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e The deleted file is moved to the Recycle bin.

e If you want the deleted file back you can open the recycle bin folder and restore the
deleted file.

o If you want file to be completely deleted without getting stored in the Recycle Bin then
choose the file and Press Shift + Del keys in the keyboard. This will erase the file even
without storing the file in the Recycle Bin.

e Once you delete the file with Shift + Del combination keys it is not possible for us to

restore the file again.

Opening a program file

Click Start->Programs->Select the program and double click
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| . Accessories

L. AntiVir PersonalEdition Classic
L ArcGIs

|. Bayesia

L DVDVideoSoft

| . Extras and Upgrades

|1 E-£soft P5P Video Conwverter
|, FuzME

L Games

W G5l

k HP

|1 HP Backup & Recowvery

| . IDRISI Andes

L InterVideo WinDWD

|. E-Lite Codec Pack

Default Prograrms | Maintenance

. Microsoft Office

Lo Microsoft Office Tools
Cpen Office Document |, Microsoft SQL Server

|, Microsoft SQL Server - Switch
.. Microsoft Visual Basic 6.0

FPrograms . Microsoft Visual SourceSafe

—

T

by
.
ad

Mew Office Docurment

W

I\

Windows Update

fan

J Meevia Docurment Conwverter
OpenOffice.org 2.1

Documents [

M0
fi &

¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥y ¥ r¥y vy ¥vy ¥

[ﬂ—’ Settings * e Roxio

2

o p Search » |l Startup
R .y Test Drive 5

— 9 Help and Support VidieolLAN

v —

E_-_i_."-l --'3'- Rur... I WIHHAH
s B2 Adobe Readers

— E Shut Dewn... M Apple Software Update
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Locating Most Recent Files

Click Start>Documents

Finding Files
Click Start> Search

| ih Administrator
| (b Documents
E Pictures
B.Tech. Bioinformatics Syllabi
= <CHFPR1
Default Programs L EHBPR1
= CHEPR2
Mew Office Document CHEPR2
=l
COpen Office Document = casylist
= fed
«!E:IP Windows Update EX] fedoraword
lec8ppt
: Programs Module_1_
- queticns
oCcuments e
software
E;/- Settings Syllabus COM 291 Data Structures and Programming in C
= Windows
o }__/\' Search G Windows_Intro_Material_Ex
w
- @ Help and Support
w
e —
=] /=y Run..
e
‘g E Shut Down...

48

www.AgriMoon.Com



Introduction to Computer Applications

Default Programs
Mew Office Document

Open Office Document

AP Windows U pdate

|
;_ Programs [
| Docurments 3

Settings [

o 1
| For Files or Folders...

@ Lo Using Microsoft Qutlook...

Help and Support
= = p For People...

Run...

=/,
@ Shut Down...

Anatomy of a Window

» Arectangular area on the desktop that is used by an application is called a Window.

Although the contents of every window are different, all windows share some things in common.
For one thing, windows always appear on the desktop—the main work area of your screen. In

addition, most windows have the same basic parts:
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File Edit Format View Help

This is some sample text inside
a Notepad window.

1) Menu bar 4 Maximize button
2 Title bar g Close button

3 Minimize button 6 Scroll bar

e Title bar. Displays the name of the document and program (or the folder name if you're
working in a folder).

¢ Minimize, Maximize, and Close buttons. These buttons hide the window, enlarge it to fill
the whole screen, and close it, respectively (more details on these shortly).

¢ Menu bar. Contains items that you can click to make choices in a program.

e Scroll bar. Lets you scroll the contents of the window to see information that is currently
out of view.

e Borders and corners. You can drag these with your mouse pointer to change the size of
the window.
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Setting Time and Date

1. Click Start, and then click Control Panel.

Internet _—} My Documents
Maozilla Firefox

P »
. E-mail

2 Microsoft Office Outiook
ICT oS0 ce Uaod -9 M‘{ Pictures

Pl
L':____”‘—' Microsoft Office Word 2007 < My Music

b My Recent Documents »

E Microsoft Office PowerPoint Q’ R
m 2007 -
g My Network Places

E Adobe Reader &
E? Control Panel

E’g Paint Set Program Access and
Defaults
B -

é Internet Explorer L= Printers and Faxes

B Motepad @) Help and Support

All Programs p =7 Run...
L,‘ﬁ’] Log Off -'{D- Turn OFf Computer

£ S5TAM Lecture 6 ks

2. Click Date and Time icon in the Control Panel Window.
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l_-:l.:! i x
TP
Ty, xlEle

-. | E Contrel Panel "

= =

Connections Wizerd e L., Devices
Bz &l Soh d
Sourd EfF, Langusge ...  Comerss Tasks

3. Set the current time

and date with the help

Date & Time | Time Zone " InternEtTunE]
of the Date and Time ~Date

~ ~Time

properties window as March . 2010 @

shown below. Then
3 W T F 5 o 3
click Apply in the 3 4 5 & ; -

MoT
12
bottom right corner of 708 8 W1l e 13 : ;
14 15 16 17 18 1% 20
the Date and Time 21 22 23 24 25 I 27 5 ;
properties window. 28 22 508
ossm |8

Current time zone: India Standard Time

| ok || cencel ][ Apoly |

4. Check the date and

time that is set in the Lioaday:March 15, 2010

system tray as shown ML

52 www.AgriMoon.Com



Introduction to Computer Applications

below

Starting Windows

1. Switch on the power supply.
2. Switch on the CPU and Monitor.

3. Windows XP splash screen will be displayed as shown below:

4

Microsoft®

Windows*P

Professional
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4. Enter the password to load your personal setting in the tab shown below:

Iy
Windows

T bpgen, chel your Lsar mamsn
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Shutting Down

e Click Start Button - Choose Turn Off Computer option

"

‘ Internet __) My Documents

Mozila Firefox
L&H\r Recent Documentts #

£ A E-mail
y Mirosoft Office Owilood

LI Cee0ee, —f:’} HF Pict
'f—:z Microsoft Office Word 2007 | (27 My Music

rz_a Microsoft Office PowerPoint g’ My Computer
I 2007

n Adobe Reader 8
E‘ Control Pansl

w Paint e. Set Program Access and
Defaults

ir__:_s Mirosoft Office Excel 2007 t":.:é Printers and Faxes

@ Nobemad tj} Help and Support

o search Click HEB

All Programs b {7 Aun... //__

.
oty (O hunoficame |

Tt

vy L‘jsrmums | E

e Click the Turn Off option in the Shut Down Dialog Box.
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LECTURE SCHEDULE 7

MSWORD: Word-processing and units of document, features of word-processing

packages. Creating, Editing, Formatting and Saving a document in MSWORD

Word-processing

o Word-processing the process of using computer to create, edit and print documents.
e Word processing is creating documents with

o0 Various font face, font styles, font sizes, font colors (eg: one, two, three)

o Different text effects (MS Word is a product °" Microsoft Corporation)

o Different alignments as shown below:

Office of the Dean Engineering
Tamil Nadu Agricultural University
Coimbatore- 641 003

Mo.Dean/AEC&RI/Edn/Examiners/Practical Exam/COM

This is to demonstrate the various alignments available in the word processing software. Using this

facility the users can left, right and centre the textin theirdocuments.

o facility to automatically correct misspelled words and grammatical mistakes

werd
ward
word
weird
wed
were

0 The ability to see how the document will look
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e To perform word processing, a special program called a word processor is in need.

e A word processor enables you to create a document, store it electronically on a disk,
display it on a screen, modify it by entering commands and characters from the
keyboard, and print it on a printer.

e Examples of Word processors

o Wordstar

Writer

Leap

WordPerfect

MS Word

O O O O

MSWORD

 MSWORD is a word processor from

Microsoft. Microsoft Word
e A computer program that enable us to

create a document, edit, format, print and

also save it for future use.

Word Screen

57 www.AgriMoon.Com



Introduction to Computer Applications

— Title Bar
—*  Menu Bar

—* Formatting Tool Bar

—» Standard Toolbar Sizing Buttons ‘_I

Word _ngﬂ

: Fie Edt Yiew | Insert | Fomat Tools Table indow  Help Type a question FArfE— ==

lnomd - wespeowronn <2 . B s p[E|lE === EimEE .2 A
Derauany|ie2@gdv-o eBEOR=@E T w0 -3, |
m ---:---jl.-u-:---?---:---3'- |:|||I|-|I|||5I-||:|||

—* Ruler Lines

Scroll Bars +=———

=l
| Previous/Next Page t
Cursor Buttons 3
¢ 3
= o[5> ( | o
Prws Iy agoshopese \ NCOE 4G EE - L-A-FEE0a .
Page 1 Sec d i A Inl Gdi  REC TRE ExT ov Engihiflis 4
— View Choices Document — ,
View Status Bar
—* Drawing Toolbar

Features of word processing

Word processors vary considerably, but all word processors support the following basic

features:
Insert text: Allows you to insert text anywhere in the document.

Delete text: Allows you to erase characters, words, lines, or pages as easily as you can

cross them out on paper.

Cut_and paste: Allows you to remove (cut) a section of text from one place in a

document and insert (paste) it somewhere else.

Copy: Allows you to duplicate a section of text.
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Page size and margins: Allows you to define various page sizes and margins, and the

word processor will automatically readjust the text so that it fits.

Search and replace: Allows you to direct the word processor to search for a particular

word or phrase. You can also direct the word processor to replace one group of

characters with another everywhere that the first group appears.

Word wrap: The word processor automatically moves to the next line when you have

filled one line with text, and it will readjust text if you change the margins.
Print: Allows you to send a document to a printer to get hardcopy.

Word processors that support only these features (and maybe a few others) are called text
editors. Most word processors, however, support additional features that enable you to
manipulate and format documents in more sophisticated ways. These more advanced word
processors are sometimes called full-featured word processors. Full-featured word processors

usually support the following features:

File_ management: Many word processors contain file management capabilities that

allow you to create, delete, move, and search for files.

Font specifications: Allows you to change fonts within a document. For example, you

can specify bold, italics, and underlining. Most word processors also let you change the

font size and even the typeface.

Footnotes and cross-references: Automates the numbering and placement of

footnotes and enables you to easily cross-reference other sections of the document.

Graphics: Allows you to embed illustrations and graphs into a document. Some word
processors let you create the illustrations within the word processor; others let you insert
an illustration produced by a different program.

Headers, footers, and page numbering: Allows you to specify customized headers

and footers that the word processor will put at the top and bottom of every page. The
word processor automatically keeps track of page numbers so that the correct number

appears on each page.

Layout: Allows you to specify different margins within a single document and to specify

various methods for indenting paragraphs.
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Macros: A macro is a character or word that represents a series of keystrokes. The
keystrokes can represent text or commands. The ability to define macros allows you to

save yourself a lot of time by replacing common combinations of keystrokes.

Merges: Allows you to merge text from one file into another file. This is particularly
useful for generating many files that have the same format but different data. Generating
mailing labels is the classic example of using merges.

Spell checker: A utility that allows you to check the spelling of words. It will highlight any

words that it does not recognize.

Tables of contents and indexes: Allows you to automatically create a table of contents

and index based on special codes that you insert in the document.

Thesaurus: A built-in thesaurus that allows you to search for synonyms without leaving

the word processor.

Creating a New Document

e Switch on the computer

e Windows displays a desktop screen with many icons on it.

e Search for Microsoft Word icon, point it with the help of the mouse and double click to
select the application.

o If MSWord icon is not on the desktop screen then Click Start->All Programs - Microsoft

Word as shown below:

‘E"‘J I ] ] ) ] o i B IE IVIN_T LS00 L X
E Microsoft FrontPage
B —cromnand Prom (L] Microsoft Cutlook:
Microsoft PowerPoink
Microsoft Powe Microsoft \Word
1 _ @ Filfazilla SErer Create and edit_ I:]a:
‘g Paink @ WimRLA R pages, or e-mail me
@ Cwberlink PowerDWD 2
@ Adobe Photoshe 77 videoLAN 4
@ TeamWiswer 3 2
) wilisoft »
£l Adobe Reader 7.0
) WinHTTrack »
Ii- start & & ™ [ Faronics 4
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o The opening word screen will get displayed as shown below. The opening screen of

word will automatically open a new document and the default name of that document will

be Documentl.

W Microsoft Word - Document]

illﬁj File: Edit Wew Insert Format Tools Table indow Help == =]
e Shy|iz=zmd o= @ B G
Marrnal = Times Mew Roman = 10 ~r| B r u |_éE_§ === i

||.E---l---1---l---2---1---3---1---4--_|

=
]
2
¥
I=le|e|=|4] | 3
| Page 1 Sec 1 11 |aE 1" lm 1 Col 1 [REE [THE o

e If you've already started Word, you create a new document by clicking New on the File
menu. In the New Document task pane that opens, click Blank document.

¢ Inthe upper-left corner of the document, or page, is the insertion point, a blinking vertical
line. Typed content will appear there.

o Keep typing continuously even if the end of the line encountered. With the help of the
word wrap property the lines will be automatically displayed in the next consecutive
lines.

e Press ENTER to start another paragraph.

Navigating Through Document

e Movement around the created document is achieved with the help of the following

operations:
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To perform this action... Press...

To move one character to the left LEFT ARROW
To move one character to the right RIGHT ARROW
To move up one line UP ARROW

To move down one line DOWN ARROW
To move to the end of a line END

To move to the beginning of a line HOME

To move up one screen (scrolling) PAGE UP

To move down one screen (scrolling) PAGE DOWN
To move to the end of a document CTRL+END

To move to the beginning of a document | CTRL+HOME

Selecting the text in the document

e To select the document in the text the following operations can be performed:

To perform this action... Press...

To select one character to the right SHIFT+RIGHT ARROW

To select one character to the left SHIFT+LEFT ARROW
To select to the beginning of a word CTRL+SHIFT+LEFT ARROW
To select to the end of a line SHIFT+END

To select to the beginning of a line SHIFT+HOME

To select the entire document CTRL+A

Editing the document

. cut

o Cut operation removes the selection from the active document and places it

on the clipboard.

0 Select the text to be cut in the document.
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0 Go to Edit menu and select Cut option or click the cut icon (3{') in the toolbar

or make use of the shortcut key combination Ctrl+X to cut the text.

e Copy
o Copies the selection to the clipboard

0 Select the text to be copied in the document.

o0 Go to Edit menu and select Copy option or click the copy icon () in the
toolbar or make use of the shortcut key combination Ctrl+C to copy the

selected text.

e Paste

o0 Paste inserts the contents of the clipboard at the insertion point (cursor) or

whatever is selected.

0 First go to the place where you want to display the cut text.

o From the Edit menu select Paste option or click paste icon (@1) in the toolbar

or press the short cut key Ctrl+V

e Find and Replace

o0 Find searches for specified text in the active document

0 To find a specified text in the document go to Edit menu choose find option or

click the find icon (!ﬁ) on the toolbar or make use of the shortcut key

combination Ctrl+F.

0 The Find and Replace dialog box will get displayed.
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Find and Replace @

Find lReglacel Go To l

Find what: |Iecture ﬂ

[ Highlight all items Found in:

| J More ¥ | Eind Mext | Cancel

o Enter the text to be searched in the Find what tab.

o Clicking the Find Next button the specified text will be located in the

document.
0 Replace searches for and replaces specified text.

0 To replace go to edit menu and select Replace option or click the replace

icon in the toolbar or make use of the shortcut key combination Ctrl+H.

o Find and Replace dialog will get displayed.

Find and Replace

Find Replace l G0 To ]

Find what: |Iecture ﬂ

Replace with: |Iecture schedule| ﬂ

More ¥ | Replace Replace all | Eind Mexk | Close |

0 Clicking Find Next and Replace buttons the specified text will be

replaced.

0 To replace all the instance of the text lecture with the text lecture

schedule click Replace All button in the Find and Replace window.
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o0 Then every instance of the text lecture in the document will get replaced

with the text lecture schedule.

Formatting the Document

e Font
o Font change font style, size, color and a large number of other features.
0 To change the font style, size of a selected text go to format menu and select

Font option or click the font icon (‘a’“) in the format toolbar.

0 The Font dialog box will get displayed.

Font l haracter Spacing ] Text Effects l

Font colar:

Eaont: Faont style: Size:
|Regular 11
Times Mew Roman g -
Trebuchet MS 9
Tunga 10
Waigai

VANAYIL_Bi_Kaviri

12 |

nderline skyle:

Automatic j | (none) j | J

Effects
[ Strikethrough [ Shadow [ Small caps
[ Double strikethraugh [ [ all caps
[ Superscript [ Emboss [ Hidden
[ Subscripk [ Engrave
Preview
Zalibri

This Font has mat been installed, The dosest available Font will be printed,

Default. ..

(0] 4 | Cancel

o0 Inthe Font dialog box choose font face, font style, font size, font color etc.

0 Click OK button then the applied font effects will get reflected in the

document.
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e Bold, Italic and Underline

o Bold, Italic, Underline - Format selected text: Bold, Italic, or Underlined

o0 To bold the text press Ctrl + B or click the bold icon ( B ) on the toolbar

o0 To underline the text press Ctrl + U or click the underline icon ( 4 ) on the

toolbar

0 To italics the text press Ctrl + | or click the italic icon ( u ) on the toolbar

e Paragraph

o Paragraph under format menu indents a paragraph using either margin or

place some chosen amount of space before or after the paragraph.
0 Select the paragraph if already entered or simply go Format menu and
choose Paragraph option or click the paragraph icon (ﬁ) in the toolbar.

o0 Paragraph dialog box will get displayed.
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Paragraph

Indents and Spacing l Line and Page Breaks

zenetal

alignmment: m outline lewvel: |Eh:n:|~;.-' kext - |

Indentation

Left: 1" = Special: B!
Right: 0" : [Hanging = [o25"
Spacing

Before: Im Line spacing: A
At e =] [orge <] | =

r

Previgw

Tabs... | Ik Cancel

o0 In the paragraph window we can set Alignment, Indentation and Spacing

for paragraphs.
o Click OK will reflect the changes in the document accordingly.

Saving the document

e To save the document for the first time click File Menu-> Choose Save As
e Save As dialog Box will get displayed.

e Select the directory where you want to save or create a new folder by clicking New

Folder icon.

e Enter the file name in the File name box.
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Fawvornte Links Name

§. Templates
Mere »

Folders b

). STAM 102 Lecture -

4. STAM 102 Lecture

|| STAM102 Lecture

L 5TAM 102 Lecture ||

)i STAM 102 Lecture

I STAM 102 Lecture
Jovicusunty - | <l

File Mame

Date md Type

#)5TAM 102 Lecture T.doc  3/17/2014

Select Directory

d AM Microsaft Office ...

L e 1AM 102 Lecture 7.doc

Save as type {wol'd Document (*.doc)

Save Button

|__Save

| [ Conca ]

e Click Save. The file is saved under the new name.

e To save subsequently click on Save from File Menu.

e Or hold the Ctrl. Key and press S from keyboard.

e Or click Save button (E) in the standard toolbar.
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LECTURE SCHEDULE 8

MSEXCEL: Electronic Spreadsheets — concepts, packages. Creating, Editing and
Saving a spreadsheet with MSEXCEL

Electronic Spreadsheet

» An electronic spreadsheet is the computer equivalent of a paper ledger sheet. It consists

of a grid made from columns and rows.

paper tedger

eat badit SH2.000
intetast 947

1]
1 of pagneits i/
mauthly pagment | $252.01 Monthly Prat. $252 61

» Spreadsheet program allows us to create professional spreadsheets and charts.

I

B C
computer ledger

car 1oan $12 000.00
interest 9.60%
# of payments 6l

» It performs numerous functions and formulas to assist us in our projects.

Electronic Spreadsheet Packages

* Examples of spreadsheet programs are:
— Lotus 1-2-3
— Corel's QuattroPro
- MS Excel

» Excel is a spreadsheet program from Microsoft, a component of Microsoft
Office for business applications. &I
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Starting Microsoft Excel

e Double click on the Microsoft

R = Microsoit Office Tooks 8

Excel icon on the desktop. = Hovel "

e Click on Start --> Programs --> 'i‘] Favontes rL_{*EI Paint Shop Pro & b
L:_"T'] Startlip ¥

Microsoft Excel “ Documents

Mictoselt Publisher
ﬁ Log Off GatesM... W] Microsoft \Word
p @8 Ms-D0S Prompt
- ) shtdown. %3 Outlock Express

EMStart|| My Computer] “ima (31 Windows Explorer

Concepts

» Spreadsheets are commonly referred to as workbook in Excel.
*  Workbooks are made up of

— columns

- rows

— and their intersections are called cells

» A workbook may contain one or more worksheets.
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Elements of an Excel Window

Formula bat Column headings

X Microzoft Excel - Book1
Menu bar ‘—“@ File | Edit ¥iew Insert Formak | Tools Data ‘WindoW Help ;Iilﬂ
Toolbar — [N H|(ERY | & B R el A e B
| ari ~w - B IO =B d% o {d.A. 7
TR
A e
Selector 4 e
Z
3
4
5 A
—|
7 E
. 8 §
Row headings 9 2
18] -
i :
—~ =
13| o
I >
15
16
17
Worksheet tabs e
15 ]
i [4]p [#Sheet1 { sheetz [ sheets / |4]
Status bar == Ready = e e

Definition of column in the worksheet

e The column is defined as the vertical space that is going up and down the window.

Letters are used to designate each column’s location.
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Definition of column in the worksheet

=0 Workbook1
A B C

1

2

5

A4

S

&

Fy

g

[ 4] » | [ Sheet1 / SheetZ 7 Sheed [<a] ]

o The row is defined as the horizontal space that is going across the window. Numbers

are used to designate each row’s location.

=0 Workbook1
A B C

1

2

3

4

>

b

Fi

8

[ A »[®], Sheet1 / Sheetz ¢ Sheed [<a] |
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Definition of cell in the worksheet

» The cell is defined as the space where a specified row and column intersect.

» Each cell is assigned a name according to its column letter and row number.

Workbook1

[III
L]

A B C

0 | el | P | T | o [ M | Pt | =

|4 4| » ][ Sheet1 / SheetZ J Sheed |<af |

» The selected cell is highlighted.
 The address or the name of the cell selected above is B6.

What a cell can contain?

» A cell may contain any one of the following types of data
— text (labels)
— number data (constants)

— formulas (mathematical equations that do all the work)

Data types Examples Descriptions

LABEL Name or ID or Days | anything that is just text

CONSTANT 5o0r3.750r-7.4 any number

FORMULA =5+3 or = 8*5+3 mathematics equation
73
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Navigating Through Cells

Movement

Key stroke

One cell up

up arrow key

One cell down

down arrow key or enter

One cell left

left arrow key

One cell right

right arrow key or tab

Top of the worksheet (cell Al) Ctrl+Home

with data)

End of the worksheet (last cell| Ctrl+End

End of the row

Ctrl+right arrow key

End of the column

CTRL+down arrow key

Selecting Cells

Cells to select

Mouse action

One cell

Click once in the cell

Entire row

click the row label

Entire column

click the column label

Entire worksheet

click Ctrl + A sheet button

Cluster of cells

drag mouse over the cells or hold down

the SHIFT key while using the arrow keys
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Creating Spreadsheet

* Move to the cell where you want to enter data and enter words or numbers.
» If data is already in the cell it will be replaced without you having to cut or delete the

previous data.

A B C
1 I-B.Sc.(Agri.) Mid Semester Mark List
2 MName STAM101 Mark STANMI102 Mark
3 Angaleeswari 87 85
4 Bharathi 92 94
5 |Covardhanan 73 90
& Dananjayen 54 58

Editing Spreadsheet

* To edit the contents of a cell
0 Select the cell, type the new contents and press enter. The new entry will be
replacing the existing contents
o Or select the cell to be edited, click on the Formula bar or double click the cell

then edit the contents and press enter.

\7Ed it Contents

| A4 + (2 %X « fx| BharathiRaja
A B C O

1 I-B.5c.(Agri.) Mid Semester Mark List

2 Mame STAM101 Mark STAMI102 Mark
3 |Angaleeswari 87 85
4 |Bharathi Raja| -I 92 54
5 |Covardhanan 73 S0
6 |Dananjayen 54 28

e Toinsertarow in the spreadsheet

o First click on the row number and choose Rows from the Insert menu. This will

insert a row before the selected row.
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IR EENEANEN:
[ o4

10 3 4

0 L L0 e

1 T Ty i T

v 590 B 40 5 % 4

e Toinsertacolumn in the spreadsheet

o0 First click on the column label (letter) and choose Columns from the Insert menu.

This will insert a column immediately left of the selected column.

A B|C|D|E AJBJC|DJEF
2 F 4 3 ! 7400
o411 16 4 71118
104 h 4 { 14 2 4
4 11 & 3 91 1 5 90 4

i | ] | P | —
i | | P | —

Saving Spreadsheet

* Click on Save As from File menu.
* Inthe Save As dialog box

0 Select the directory

o Enter the file name

o Click on Save button
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[ save s [
() [ « SRDEI » Desktop » STAM102 »

5
‘ :._.:"D_.Elr‘lizl': -

BER
BEE eyt
mmg T

Exniite Links Name Date modified
4 coml01 ]
| Documents Select Directo
¥ 1 STAM 102 Lecture 1 =
Mare »
L. STAM 102 Lecture 2
Folders ¥ |l STAM 102 Lecture 3
|| | STAM102 |} STAM 102 Lecture
J comlol |, STAM 102 Leeture 5

L STAM102 Lectui | | STAM 102 Lecture6

Ji STAM 102 Lectul ] J STAM 102 Lecture 7 incomplete
1 STAM 102 Lectw Ji sts

Lo STAM102 Lectu
A STAM 102 Lectw ™ |

File Name

File name: Mark list Save Button -

Save as type: | Excel Workbook e -

» To save subsequently Click on Save from File menu
* Or hold the Ctrl. Key and press Enter key

* Or press Save button (E) in the Tool Bar.
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LECTURE SCHEDULE 9

Use of in-built functions and writing expressions

In-built Functions

e A function is an in-built program, which is used to do a particular task.
¢ Functions take the input the input and will give the result as the output.
e Based on the input and output data the functions are categorized as

0 String functions
Arithmetic functions
Date functions

Logical functions

O O O o

Group functions

Use of in-built function SUM()

To use in-built functions enter the data to prepare mark list of the I- B.Sc.(Agriculture) students

in the spreadsheet.

L= = RN R = R L B R R N I

A B C D E
I-B.5c.(Agri.) Mid Semester Mark List
Mame STAMIO01 Mark STAM102 Mark AGR101 Mark PBG101 Mark
Angaleeswari 87 85 86 84
Bharathi Raja 92 94 96 97
Covardhanan 73 50 g4 58
Dananjayen 54 58 60 63
Elevanthan 73 76 77 75
Gayathri 66 S6 57 86
Hariprasad 61 65 66 g4

e Using the in-built function SUM() we can calculate the total scored by each and every
student in I-B. Sc. (Agri.).

e Add Total column in the spreadsheet as shown below:
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WD =] Ln s R

A B C b F
I-B.5Sc.{Agri.) Mid Semester Mark List

Mame STAMI101 Mark STAML02 Mark AGR101 Mark PBG101 Mark Total
Angaleeswari 87 85 86 B84 |
Bharathi Raja 92 94 96 97
Covardhanan 73 90 64 58
Dananjayen 54 58 60 63
Elevanthan 78 76 77 75
Gayathri 66 56 57 86
Hariprasad 61 65 66 64

Place the mouse pointer in the cell with the address F3

The F3 cell is the one which should display the total mark scored by the student namely

Angaleeswari in the above example.
Click on Insert Menu = Function
or Select f, in the Formula bar

Insert Function dialog box will get displayed as shown below:

i

Insert Function I.ilﬂ_hj

Search for a function:

Type a brief description of what you want to do and then dick
Go

0r select a category: | Most Recently Used E

Select a function:

-
AVERAGE

IF 1
HYPERLINK E
COUNT i
MAX
SIN

SUM{numberl,number?,...)
Adds all the numbers in a range of cells.

4

Select SUM function and click OK button in the Insert Function dialog box.

The function Argument dialog box will be displayed with the automatically assumed

range of cells to be added(B3 to E3)
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A B E B 1 J K L
1 I-B.Sc.(Agri.) Mid Semester Mark List
2 |Name STAM101 Mark STAM102 Mark AGR101 Mark PBG101 Mark Total
3 |Angaleeswari 87 85 86 S4|I(B3:E3} -l
4 Bharathi Raja 92 94 96 97
5 |Covardhanan 73 90 Function Arguments D (i
6 Dananjayen 54 58
5UM
7 |Elevanthan 78 76
8 Gayathri 66 56 Number1 | SEHER)
9 |Hariprasad 61 65 MNumber2
10
11
12
13
0 = 342
= Adds all the numbers in a range of cells.
16 Numberl: numberl,number2,... are 1 to 255 numbers to sum. Logical values and text
are ignored in cells, induded if typed as arguments.
17
18
19 Formula result = 342
20 Help on this function ok | [ concel
21

e Click OK. The result is displayed as shown. We can even choose the range of cells

added manually.

A C D F
1 I-B.Sc.(Agri.) Mid Semester Mark List
2 |Mame STAM101 Mark STAMI102 Mark AGR101 Mark PBG101 Mark Total
3 Angaleeswari 87 85 86 84 3421
4 |Bharathi Raja 92 94 96 97
5 |Covardhanan 73 50 B4 58
& Dananjayen 54 58 60 63
7 |Elevanthan 73 76 77 75
g Gayathri 66 56 57 26
5 Hariprasad 61 65 66 64

e The total marks scored by the other students have to added in the same way by making

use of the SUM() function.

e Instead entering the same function for all the students in the example we can copy the
formula to the cells in the total column to add B4:E4, B5:E5, B6:E6 and so on.

¢ When we copy the SUM() function formula from the cell F3 to F4 the SUM function will

automatically taking the input range of numbers to be added is B4:E4.

o The same is applicable to the rest of the cells in the total column.

e To copy down the formula place the mouse pointer at the bottom right corner of the cell

F3.
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The mouse pointer now automatically changes into + symbol.

Now drag + symbol down the cells in the Total column.

We can see the total marks of all the students in the example as shown below.

Use of in-built function AVERAGE()

L= = R R = R R A R

A

I-B.Sc.(Agri.) Mid Semester Mark List
STAML01 Mark STAMI102 Mark AGR101 Mark PBG101 Mark Total

MName
Angaleeswari
Bharathi Raja
Covardhanan
Dananjayen
Elevanthan
Gayathri
Hariprasad

B

87
92
73
54
78
66
61

C

835
94
90
58
76
56
b5

D

80
96
64
60
77
57
6o

E

&4
97
58
63
75
26
64

F

342
379
285
235
306
265
256

To calculate the average marks scored by the students in the example we can make use

of average function AVERAGE().

Enter Average column in the spreadsheet.

Place the mouse pointer in the cell with the address G3

The F3 cell is the one which should display the total mark scored by the student namely

Angaleeswari in the above example.

Click on Insert Menu = Function

or Select f, in the Formula bar

Insert Function dialog box will get displayed as shown below. Choose AVERAGE()

function and click OK.
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A B C D E F G H 1 ] K
1 I-B.Sc.(Agri.) Mid Semester Mark List
2 |Name STAM101 Mark STAML0Z Mark AGR101 Mark PBG101 Mark Total Average
3 |Angaleeswari 37 85 86 84 342|= |
4 |Bharathi Raja 92 94 96 Insert Function @Iﬁ
5 Covardhanan 73 90 64
& |Dananjayen 54 58 50 Search for a function:
7 |Elevanthan 78 76 77 Type a brief description of what you want to do and then dick -
: s s |
8 |Gayathri 66 56 57
9 |Hariprasad 61 65 66 Cr select a category: Most Recently Used |z|
10 Select a function:
1 SUM -
12 AVERAGE b
F =
13 HYPERLINK
COUNT
14 MAx
15 SIN i
16 AVERAGE(numberl,number2,..}
17 Returns the average (arithmetic mean) of its arguments, which can be numbers ar
names, arrays, or references that contain numbers.
18
19
20
21 Help on this function [ oK ] ’ Cancel
22
e Click OK button in the Insert Function dialog box.
e In the Function Argument dialog box enter F3/4 then click OK button. The average
scored is displayed.
A B C D E F G | J K L M
1 I-B.5c.{Agri.) Mid Semester Mark List
2 |Name STAM101 Mark STAML102 Mark AGR101 Mark PBG101Mark Total Average
3 |Angaleeswari 87 85 86 84 342| E{F3/4) -l
4 Bharathi Raja 92 94 96 97 379
5 Covardhanan 73 90 Function Arguments @Iﬂ
6 Dananjayen 54 58 AVERAGE
7 |Elevanthan 73 76 Number1 |F3/4 o
8 Gayathri 66 56 N N
9 |Hariprasad 61 65 Mumber2 number
10
11
12
L = B85.5
14 Returns the average (arithmetic mean) of its arguments, which can be numbers or names, arrays, or references that
15 contain numbers.
16 Numberl: numberl,number2,... are 1 to 255 numeric arguments for which you want the
17 average.
18
13 Formula result = 85.5
20 _ )
21 Help on this function [ OK ] [ Cancel
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e Copy the AVERAGE formula as we copied the SUM().

A B C D E F G

1 I-B.5c.{Agri.) Mid Semester Mark List

2 MName STAMI101 Mark STAML102 Mark AGR101 Mark PBG101 Mark Total Average
3 Angaleeswari a7 85 86 84 342 85.5
4 |Bharathi Raja 92 94 96 97 379 94.75
5 |Covardhanan 73 90 64 58 285 71.25
& Dananjayen 54 58 60 63 235 58.75
7 |Elevanthan 78 76 77 75 306 78.5
8 Gayathri 66 56 57 86 265 66.25
9 Hariprasad 61 65 66 64 256 6

Writing Expressions

e The total marks can be calculated by writing expressions.
e Place the cursor the cell F3.

e To enter expression, enter the equal sign first.

AVERAGE -0 X K=
A B C D E F G

1 I-B.5c.{Agri.) Mid Semester Mark List
2 MName STAMIL01 Mark STAML02 Mark AGR101 Mark PBG101 Mark Total Average
3 Angaleeswari 87 83 86 84| =
4 Bharathi Raja 92 94 96 97 |
5 |Covardhanan 73 90 64 58
& Dananjayen 54 58 60 63
7 |Elevanthan 78 76 77 75
8 Gayathri 60 56 57 26
9 Hariprasad 61 B5 66 64

e Choose the cells with the cursor as sown

A B C D E F G
1 I-B.5c.(Agri.) Mid Semester Mark List
2 Mame STAMI101 Mark STAMI102 Mark AGR101 Mark PBG101 Mark Total Average
3 Angaleeswari [ E}"I E-SI E-ﬁz:::::::::j =B3+C3+D3+E3
4 Bharathi Raja 92 94 96 97
5 |Covardhanan 73 50 B4 58
& Dananjayen 54 58 60 63
7 |Elevanthan 73 76 77 75
g Gayathri 66 56 57 86
5 Hariprasad 61 65 66 64
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e Press enter. The result will be displayed in F3. Copy the expression down the Total

column to find the total mark scored by all the students in the example.

e To calculate the averages place the G3.
o Enter the equal sign first in the cell G3.

o Enter F3/4 which is the average to be calculated.

L= e B B = T N O R O R

A B C D
I-B.5c.{Agri.) Mid Semester Mark List

MName STAMI101 Mark STAMI102 Mark AGR101 Mark

Angaleeswari 87 83 86
Bharathi Raja 52 54 96
Covardhanan 73 30 54
Dananjayen 54 58 60
Elevanthan 78 76 77
Gayathri 66 56 57
Hariprasad 61 65 66

o Press enter. The average will be displayed. Copy the

Average column to calculate the rest of the averages.

E F G
PBG101 Mark Total Average
sal  3a2-r3/q
97 379
58 285
63 235
75 306
80 265
64 256

expression down the cells in the

W0 |~ b w | M|

A B C D
I-B.5c.{Agri.) Mid Semester Mark List
MName STAMI101 Mark STAMI102 Mark AGR101 Mark
Angaleeswari 87 83 86
Bharathi Raja 92 94 96
Covardhanan 73 50 54
Dananjayen 54 58 60
Elevanthan 78 76 77
Gayathri 66 56 57
Hariprasad 61 B3 66
84

PBG101 Mark Total
84
97
58
03
75
86
o4

€]
Average
342 85.3
379 94.75
285 71.25
235 58.75
306 76.5
265 86.25
256 64
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LECTURE SCHEDULE 10

Data Analysis Tools- Correlation and Regression, t-test for two samples and

ANOVA with One-way classification

Data Analysis Tools

e Most of Excel’s statistical procedures are part of the Data Analysis ToolPak. This option

is available in TOOLS menu.
e The analysis that can be done are:
descriptive statistics,
t tests,
correlations,
one or two way analysis of variance,

regression,

O O O o o o

moving average,

o Fourier analysis etc.

e To start the data analysis click Tools menu. Search for the Data Analysis tab in the Tools

menu.
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MLy

Tools | Data  Window  Help
v Speling... F7
\@/) Error Checking. ..

Speech ()
Share Workbook, .

Track Changes 3

Protection b
Online Collaboration 3
zoal seek.. .
Scenarios.
Faormula Auditing 3
Toals on the Web, ..
Macra b
Add-Ins. ..

ZE  AutoCaorreck Options...

Cuskomize. .,

Cptions. ..

e |If Data Analysis is not found in the menu
then click Add-Ins...

e In the Add_Ins dialog box check Analysis
ToolPak. Then Click OK.

86

Now choose the Tools menu. You

can find the Data Analysis there.
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Add-Ins

gdd-Ins available:

] 4
| Analysis ToolPak - YBA
| Conditional Sum Wizard Cancel
| Euro Currency Tools
| Inkternet Assistant WE&
| Lookup ‘Wizard Browse. .
| Solver &dd-in .
Aukamation. ..

Analysis ToolPak

Prowvides functions and interfaces For financial and

[

scientific data analysis

Click Data Analysis option in the Tools now.

Tools | Daka  ‘Window  Help

% apeling...

s@ Error Checking...
Speech
share Workboaol. ..

Track Changes

Protection
Cnline Callaboration
Goal Seek...
Scenarios, .,
Formula Auditing
Toaols on the Weh. ..
Macro
add-Ins...

3= AutoCorrect Opions...
Customize., ..

Cptions, ..

F7

Data Analysis. ..

Data Analysis dialog box will get displayed as shown:
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Data Analysis

analysis Tools

] 4
Anova: Single Fackar -
Anowva: Two-Fackor With Replication — ancel
Anova: Two-Fackor Withouk REEIicatinn
Covariance Help

Descriptive Statistics
Exponential Smoothing
F-Test Two-Sample for Yariances

Fourier Analysis
Hiskogran j

Correlation

e To do the correlation we consider a problem of finding correlation coefficient of data
which relates to the Yield in grams (Y) and the Matured Pods (X) of 10 groundnut plants.

e The data is entered in the Excel sheet as follows:

A B C D E F
1 The followingf data relates to the Yield (in gms)and Matured Pods in numbers of 10 groundnut plants
Z Yield(Gmsz) Matured Pod(in numbers)
3 14 16
4 34 40
A 20 21
B 16 13
7 11 14
g 11 13
4 20 Ll
10 17 3
11 22 17
12 17 27

¢ Choose Correlation from the Data Analysis window then click OK button.

e Correlation window will get displayed as follows:
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Correlation
Input =
Input Range: || y
Cancel
Grouped By: & Colurnns
" Rows Help

[ Labels in First Fow

Cutput opkions
" Qutpuk Range: | E
&+ Mew Warksheet Bly: |
" Mew Warkbook

e Enter the input range if you know the input range of data or else make use of the
address icon to mark the input range in the Excel sheet. In this example the input range
is A2:B12.

e Since the data are grouped by column in this example, choose Grouped By Columns
option.

e We can add the labels as the first row in the data range. So check the Labels in First

Row.

e In the output options choose where you want to display the output. In this example the

output range is given as D2.

Correlation
Input oF
Input Range: |$A$2:$B$12 E
Cancel
iSrouped By: * Calurnns
O Rows Help

v Labels in Firsk row

Ckput options
&+ Qutput Range: |D2 E
" Mew Warksheet Ply: |

{7 Mew Workbook

e Click OK button in the Correlation window.

e The result will be displayed from D2 as shown below:
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i ( [ ; i
| tes tothe Yield (m gms)and Matured Pods in numbers af 10 graundnut plants
2 Matured Pod(in numbers) ViehiGms) - Matured Poufin mmbers)
] b Vil o] 1
4 { Matured Padin numbers] 072362000 1
d /I
b I8
7 I
i i
J i
Il ¥
I If
. q
Regression

e To do the regression analysis we consider an example with paddy yield in Kg as
dependent variable and ear length in cm as the independent variable.

e The data are entered in the Excel sheet as follows:
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A, B C D
1 | The followingt data refers to the paddy yield {in Kgland ear length in{ crm’
2 Faddy Yield(kg) Ear Length (cm)
3 3.5 15
4 4.15 17
5 3.8 14
B 4.2 15
7 3.95 17
] 417 19
=) 435 20
10 4.32 22
11 5.01 17
12 4.87 16
13 | 4.05 17
14 4.28 20
15 4.5 22
16 4.1 20
17 472 24
18 4.5 18
19 4.1 17
20 465 19
21 4.859 20
22 4.99 18

e The Regression procedure in the Data Analysis tools lets you choose one column as the
dependent variable, and a set of contiguous columns for the independents

¢ It does not tolerate any empty cells anywhere in the input ranges.

o Therefore, if there is any empty cells in the input range, delete the rows contain empty
cells.

e Choose Regression from Data Analysis and click OK.

Data Analysis

analysis Tools

ik

Histogram ﬂ

Maoving Average Cancel
F.andam Mumber Generation
F.ank and Percentile

Help

Regression

Sampling

k-Test: Paired Twao Sample For Means

E-Test: Two-3ample Assuming Equal Yariances

E-Test: Two-3ample Assuming Unequal Yariances

z-Test: Twio Sample For Means ~

91 www.AgriMoon.Com



Introduction to Computer Applications

e In the Regression window enter the Y and X ranges if you know the address values or

else the click the colored icon in the Y and X range tabs to fill the addresses.

e |f the first row of the data entered includes labels then check the Labels box in the

Regression window.

e Let the confidence level be set to 99%.

e In the output options choose where you want to display the output of regression

analysis. In this example the Output Range is set to E2.

Inpuk

Cukpuk options
(¥ Cutput Range:
™ Mew Warksheet Ply:
™ Mew Workbook,

Residuals

[ Residuals
[ standardized Residuals

Marmal Probabiliby
I Normal Probabilicy Ploks

v Confidence Level: 99 P

Input ¥ Range: e
Input = Range: |$.ﬁ.$2:$.ﬁ.$22 E
v Labels [ Caonsktant is Zero

[$E4=

[ Residual Ploks
[ Line Fit Plots

Cancel

Help

e Click OK. The result will be displayed fro E2 as shown below:
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E F (5 H J ke L el

s
[y
EAlS

sUMMARY OUTPUT

Regression Stalistics
Multiple R 0.410574
F Sguare | 0.168571
Adjusted F 0.122351
Standard B 2304758
Dbservatio 20

ANCYA

df o s F lgnificance F
Regressior 10 19.38567 19.38567 3649474 0.072151
Residual 18 9561433 5311907
Total 19 115

Coefficlentdandard Exry ¢ 5tal | P-valle Lower 95% Upper 9555 ower 99, 0% aner 99, 0%
7811454 5618729 1390253 0181405 -3.99307 1961897 -8.36173 23.98464
245855 1286957 1.91036 0072151 -024525 5162343 -1.24535 616295

Intercept
Faddy Yie

_,._\_,._L_;_,._x_,._x_,.
i I A e A = =T At A R Rl e e

t-test for two samples

o t-test for two samples assuming Perform t-test for two samples assuming equal
variances: yield of food in kg/ha in Kharif and Rabi season from 1996-97 to 2006-07.

e The data is entered in Excel sheet as shown below:

A B C 0 E F G H | J K

1 Perform t-test for two samples assuming equal varinces: yield of food in kgdha in Khanif and Rabi season from 1996-97 to 20
2 |Year Kharif

3 96 89 104

4 97-95 94 109

5 595-99 94 116

B 95-2000 78 105

7200001 93 120

§ 2001-2002 95 119

9 2002-2003 92 130

10 2003-2004 106 131

11 2004-2005 104 134

12 2005-2006 105 142

13 2006-2007 110 145

e Choose t-Test: Two-Samples assuming Equal Variances in the Data Analysis window:
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Data Analysis

analysis Toaols

t-Te

0] 4
Histagram ﬂ -
Moving Average Cancel
F.andom Murmber Generation
F.ank and Percentils
Regression Help
Sampling

E-Tesk: Twn-53 uming Equal Yariances
E-Tesk: Two-Sample Assuming Unequal Yariances
z-Test: Two Sample For Means =

st Paired Two Sample For Means

t-Test: Two-Sample Assuming Equal Yariances [?I['STI

Input
Varia

In the t-Test: Two-Samples assuming Equal Variances window enter the Variable 1

Range and Variable 2 Range.

Check the Labels option
Hypothesized mean difference be 0.5
Let Alpha value be 0.05

Set output range as E2.

be 1 Range: TR
blz 2 Range: |$C$2:$C$13 E Cancel

Waria

Hypothesized Mean Difference: lElSi ﬁ
[v Labels

alpha: |0.05

Output options
¢ Qutput Range: |$E$2 y
" Mew Worksheet Bly: |

T Mew Workbook,

The result will be displayed from E2 as shown below:
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A

Year
9697
§7.98
6899
69-2000
2000-01
2001-2002
2002-2003
10 2003-2004
11 2004-2005
12 20052006
13 2006-2007
14

15

16

OO0 | O T e G B —

106
104
105
110

104
109
116
105
120
119
130
131
134
142
145

E F

G H | J K

Perform t-test for two samples assuming egual varinces: yield of food in kha in Khanf and Rabi season from 139697 to 2

t-Test: Two-oample Assuming Equal Yanances

Fharif

Rahi

Mean  SB.3k3bd 1231816
Variance | 0405455 203.3645

Ohservatio 11
Pooled Ya 1440041
Hynothesi; 0.5
df 20
t Stat -5.33873
P(T<=t] on 1.53E05
t Critical o 1.724718
P(T=t) tw 3.17E05
t Crtical tv 2.085%2

11

ANOVA with One-way Classification

o Perform ANOVA One Way Classification for yield of food in kg/ha in three seasons from
1996-97 to 2006-07

e The data is entered in Excel sheet as follows:
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A B C D E F G H
1 |Perform ANOVA One Way Classification for yield of food in kg/ha in three seasons from 1996-97 to 2006-07
2 Year  SEASON1 SEASON2 SEASON3
3 9697 89 104 130
4 1979 9 109 134
5 98-99 9 116 135
6 199-2000 78 105 135
71200001 93 120 142
g 12001-2002 95 119 143
9 12002-2003 92 130 144
10°12003-2004 106 131 150
112004-2005 104 134 152

12 12005-2006 105 142 154
13 12006-2007 10 143 160

o Choose ANOVA: Single Factor from Data Analysis window.

e -1
T—

Data Analysis
Analysis Tools
JAnova; Single Factor [
Anova; Two-Factor With Replication Cancel
Anova: Two-Factor Without Replication j ;]
Correlation 3
Covariance
Descriptive Statistics

Exponential Smoothing

F-Test Two-Sample for Variances
Fourier Analysis

Histogram [V]

In the ANOVA: Single Factor window enter the input range. The input range in the
example is B2:D13

e Choose Group by Columns

e Check Labels in the first row

e Output range is set to F2 as follows:
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— | e . -
Dmm-un_—nr_n.l_-.t_um_.

12
13
14
15
16
17

A B E F G H |
Perform ﬁ[x]‘[:j“n,“,&-‘[j‘|le-'f"3-. @|E|§§|1'E§tln‘n‘1ij[ W I.Eld of foplinlentha in thras ecaeone from 10007 40 IA0GA7
Year  \SEASON1 SEASON? SEH—RSDHH. Anova: Single Factor
9697 ) 89 104 KU
?' - - (o= 0K
we | w v ng | P mm 5
992000 ! 78 105 135 | Groupedsy ® Columns
200001 93 120 142! O Rows
2001-2002, % 119 143, [v] Labels in first row
2002-2003, 92 130 144) sphas
2003-20041 106 131 150, -

2004-20051 104 134 1524 .
Qutput opti
20052008 105 wp g | R _
2006200 M I 1601 (® Qutput Range: 2 R
() Mew Waorksheet Ply:
O New Workbook

e The result of the ANOVA with One-way classification is displayed from F2 as shown below:

A

B

C

D

F

~

b

H |

{ Perform ANOVA One Way Classification for yield of food in ky/ha in three seasans from 1996-57 to 2006-07

2 Vear

3%
4 979
5 9699

6 99200
7200040
¢ 2001-
§ 2002-
10 2003
11 2004-
12 2005-
13 2006-

14
15
16

I

J
;

0
1
0
0
0
0
0
007

200
20
200
2005
200
2007

i
W
W
18
%
%
52
106
104
103
110

14
104
116
103
120
119
130
131
13
142
14

SEASONT SEASONZ  SEASON3

130
13
135
13
142
143
144
150
152
154
160

Anava: Single Factor

- .
=
—

SUNMARY
Groups Gt Sum Average Varance

SEASONI 11 1060 96.36364 64 63455
SEASONZ 11 135 1231818 203363
SEASONA 11 1579 1435455 9167273
ANDVA

Source of Vanation 3 o M Foo Pl Fot
Batween Groups 12320 06 2 616003 4367141 382E-10 331583
Wihin Groups 3796.909 30 1265636
Total 16116.97 3
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LECTURE SCHEDULE 11

t-test for two samples and ANOVA with One-way classification

t-test for two samples

e t-test for two samples assuming equal variances:

e Example: Perform t-test for two samples assuming equal variances for yield of food in
kg/ha in Kharif and Rabi season from 1996-97 to 2006-07.

e The data is entered in Excel sheet as shown below:

A B C D E F G H | J K

1 Perform t-test for two samples assuming equal varinces: yield of food in kg'ha in Kharif and Rabi season from 199657 ta 20
2 Year Kharf

3 9697 a9 104

4 9793 94 109

5 9599 94 116

B 992000 78 105

7200001 93 120

g 2001-2002 95 119

9 20022003 92 130

10 20032004 106 131

11 2004-2005 104 134

12 20052006 105 142

13 2006-2007 110 145

o Choose t-Test: Two-Samples assuming Equal Variances in the Data Analysis window:

Data Analysis

analysis Toaols

K

Histagram
Moving Average

Cancel

F.andom Mumber Generation

Fank and Percentile

Regression

Sampling

k-Test: Paired Two Sample For Means

t-Test: Two-Sample Assuring Equal Yariances
t-Test: Two-Sample Assuming Unequal Yariances
Z-Test: Two Sample For Means

i

Help
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e In the t-Test: Two-Samples assuming Equal Variances window enter the Variable 1

Range and Variable 2 Range.
e Check the Labels option
e Hypothesized mean difference be 0.5
e Let Alpha value be 0.05

e Set output range as E2.

t-Test: Two-Sample Assuming Equal Yariances

v Labels

flpha; |0.05
Cubput options
o Qukput Range: |$E$2 E
T Mew Worksheet Ply: |

" Mew Workboaok

?x)
Input
Wariable 1 Range: |Eﬁm§_y

Wariablz 2 Range: |$C$2:$C$13 y Cancel
. . Help
Hypothesized Mean Difference: 0.5

e The result will be displayed from E2 as shown below:
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A

Year
9697
§7.98
6899
69-2000
2000-01
2001-2002
2002-2003
10 2003-2004
11 2004-2005
12 20052006
13 2006-2007
14

15

16

OO0 | O T e G B —

106
104
105
110

104
109
116
105
120
119
130
131
134
142
145

E F

G H | J K

Perform t-test for two samples assuming egual varinces: yield of food in kha in Khanf and Rabi season from 139697 to 2

t-Test: Two-oample Assuming Equal Yanances

Fharif

Rahi

Mean  SB.3k3bd 1231816
Variance | 0405455 203.3645

Ohservatio 11
Pooled Ya 1440041
Hynothesi; 0.5
df 20
t Stat -5.33873
P(T<=t] on 1.53E05
t Critical o 1.724718
P(T=t) tw 3.17E05
t Crtical tv 2.085%2

11

ANOVA(Analysis od Variances) with One-way Classification

e Example: Perform ANOVA One Way Classification for yield of food in kg/ha in three
seasons from 1996-97 to 2006-07

e The data is entered in Excel sheet as follows:
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A B C

E

H

1 Perform ANOVA One Way Classification for yield of food in kg/ha in three seasons from 1996-97 to 2006-07
2 Year  SEASONT SEASONZ - SEASON]

3 %6497 it 104
4 1979 el 109
3 9599 el 16
6 99-2000 i 103
71200001 3 121

g 2001-2002 95 119
9 12002-2003 92 130
1012003-2004 106 131
1112004-2005 104 134
1212005-2006 103 142
1312006-2007 ll 143

e Choose ANOVA: Single Factor from Data Analysis window.

130
134
133
133
142
143
144
150
152
154
160

Exponential Smoothing

F-Test Two-Sample for Variances
Fourier Analysis

Histogram

v

[ =]
- -l
Data Analysis
Analysis Tools
Ok

*Anova; Single Factor
Anova: Two-Factor With Replication Cancel
Anova: Two-Factor Without Replication
Correlation
Covariance el
Descriptive Statistics

¢ In the ANOVA: Single Factor window enter the input range. The input range in the

example is B2:D13

e Choose Group by Columns
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e Check Labels in the first row

e Output range is set to F2 as follows:

A

B

E F

-

"

I Perform ANOVA One Way Classfcation for yield of fooginka/hain theaa eaaeans fiom 190R.07 40 J00AAT

2 Year \SEASONT SEASONZ SEASON3)

3 0547
4979
5 9899
6 99-2000
7200041 !
3 20012002,
9 12002-2003)
10 2003-200
1 znm-znnai
12 2005-200
13|2006-2007
14

15

16

{7

e The result of the ANOVA with One-way classification is displayed from F2 as shown below:

it
94

104
109
116
103
120
119
130
131
134
142

1301
1345
35

Anova: Single Factor

Input
Input Range:

Grouped By:

Labels in first row
Alpna: 10,05

Qutput options

@ Qutput Range:

() New Warksheet Ply:
(O New Workback

E0E |
(3) Calumns

O Rows

42 i3

Ok

Cancel

Help
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A B C

| Perform ANOVA One Way Classification foryield offood n kg/ha in three seasons from 1986-97 to 2006-07
2 Year  SEASONT SEASONZ - SEASON]

3% ik 104
494 U 109
5 %9 U 1
6 932000 I 103
T 200041 i 120
g 20012002 % 19
9 20022003 ), 130
1020032000 106 131
s 1o 14
22002006 105 142
A0 1 143
4

fa

f6

13
14
1%
1%
142
143
14
)
12
14
il

F G | A | J K| L
Anoia: Singe Factor
SUMMARY
Groups Cot & Average Vanance
SEASONY i1 1060 9536364 8463455
SEASONZ I 135 1231618 203.36%
SEASON] 1979 143545 9167203
AHOVA
Souree of Varafion S8 M F Pule Fet
Befean Groups 1232006 2 616003 4867141 3GZE10 331963
Within Groups %909 30 12656%
Totd ey 3
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LECTURE SCHEDULE 12

CREATING GRAPHS

Graphs or Charts

o The graphical representation of data is called graph or chart.

e The data entered in the excel sheet can be represented by a graph or a chart.
e MSEXCEL supports a wide variety of graphs.

e Example of graphs:

o Column, Line, Bar, Pie, Area, Doughnut, Radar, Surface, Bubble, Stock etc.

Column Graph

e It shows data change over a period of time or illustrates comparisons among items.
e Categories are organized horizontally and values vertically.

e |tis anidel chart for showing the variation in the value of an item over period of time.

Bar Graph
e Bar graph illustrates comparison among individual items.

e Categories are vertically organized and values horizontally.

Line Graph

e Aline graph shows trends in data at equal intervals.
e ltis very useful to show the change in the value over a period of time.

o It will show very clearly whether a value is ascending or descending.
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Pie Chart
e Pie chart is used to plot data for a single data series.
o Each data point is represented by one piece of the circular pie chart.

e The size of each piece is proportional to the value it represents, so all the data points

taken together will form circle.

Area Graph

e Area chart is similar to line chart.
o But plots series one above the other with different colors and shades.

¢ It emphasizes the magnitude of change over a period of time.

XY (Scatter) Graph

e It plots each point with a mark of two groups of numbers as one series of XY

coordinates.

e |t shows uneven intervals of data and it is commonly used for scientific data.

CREATING GRAPHS

o Create a spreadsheet with data rice yield in tones from the year 1998 to 2004 as shown

below:
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A, E

T Rice Yield Analysis

2 Year Rice Yield (tones)
£ 19498 o246 858 .95
4 19494 g95 745 77
%) 2000 1,025 892 B2
b 2007 2,048 955 55
Fi 2002 H.895 4458 24
o 2004 102 584 65
2 2004 0 B83 520 25

e Go to Insert Menu select Chart and click.

Insert | Format Tools [Da

Cells, .,

Riows
Columns
Worksheet

|ﬂ Chark. ..

Swmboal, ..

1 f&% Function...

:
Marne k

g Comment
Picture k

fge Diagram...
Qbiject, ..
% Hyperlink...  Ckrl4+kK
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First Step

e A dialog box of chart wizard will appear, select the required type of chart from the chart
type.

Chart Wizard - Step 1 of 4 - Chart Type

Standard Types l Custom Types

Chark kvpe: Chart sub-type:

- Y (Scatker)

_ Area

@ Doughnut

@r Radar —
i Surface i
@ Eubble

[ﬁiﬁ Skack,

categories,

Press and Hold to Yiew Sample

ilelaflil.l
()| i

Clustered Column, Compares walues across

Cancel |

| [ext = | Finizh

e Then select the chart sub type according to your requirement.

Second Step

e Select the data range in this step.

e To give enter data range move the cursor on excel sheet and

0 by clicking select the data area you want or

0 type cells position if you know exactly which area you want.

e Click on the Next button.

e the data range selected in our example is Sheet1!$A$1: $B$9

e Sheetl we are in sheetl in MS Excel.

e $ Sign is used to represent the absolute position of the data in MS Excel.
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e The range is to conform that the chart is being prepared of the proper sheet of the file.

e On confirming click on Next button.

@

@ File Edit ‘“iew Insert Format .
c',!'o i [Daka Range l Series l
A1 - A 12000000
iy B 10000000
1 E Rice 1'|IriEI':l AnaIYSis -E F000000 O Rice ield &nalysiz Tear
2 ! Year Rice Yield {tonnES? B000000 B Rice icld Analysiz Rice
31 1993 546,858 .95 § 4000000 Tisld [tonnes]
4 19959 gu5, 745 77 ) 2000000
g | 2000 1,025 892 B2 E ol
4] E 2001 2,548,955 .55 L
7l 200% 5,805 458 25 )
8| 2003 7.102 584 B5 |
I ! ! L Dat 8 = : =%
q 'L____E_D_Dfl “““ @,_B_B_SJEEE;E_E_: Llata range Sheetl 8%l $B$9| J
10 Series in: " Rows
11 * Columns
12
13
14
15
16
17
18 @ Zancel < Back | Mext = | Finish
19
Third Ste

e Here the Chart title, Category and Value information are entered, which will be displayed

when the chart is viewed.
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Chart Wizard - Step 3 of 4 - Chart Options

Titles l Axes l aridines l Legend l Data Labels | Data Table

Chart title:
|E|_D AMALYSIS CHART RICE YIELD ANALYSIS CHART
Category (%) axis: E 12000000
|"|“EF'.FL Z 1000000
=]
Yalue () axis: '; F000000 O Riice Tield Analysiz
- = I ¥ ear
|RICE YIELD (I TOMMES) gt U (= e i i
& 4000000 Rice Yield [tonnes]
F
| W 2000000 Il I I
g el
12 3 45 61
| TEAR
@ Cancel < Back | Mext = | Finish

Click Next button.

Fourth Step

This step will provide in the way you want to place the chart.

Select the appropriate option available in the chart wizaerd.

Chart Wizard - Step 4 of 4 - Chart Location

Place chart:

" &5 new sheet: |Chart1

Cancel | < Back. |

G rscbiectin [ - |

Einish

Click the Finish button.

The chart will be as shown below:
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2 B C O E F
1 Rice Yield Analysis
2 | Year Rice Yield (tonnes)
3 1998 246,858 .95
4 1994 BYS 74577
5] 2000 1,025,892 62
B 2001 2,548 955 55
7 2002 5,895 458 25 RICE YIELD ANALYSIS CHART
ﬂ 2003 7,102,584 65
g 2004 §,883,5629.25 12000000
10 £ 10000000 O Rice ‘r’ileld
11 a & goo0oao Analysis Year
12 Q2 5000000 - -
14 .0 4000000 - B Rice ‘ﬂleld |
14 Q - 2000000 4 Amlyms Rice
15 o 7. Yield (tonnes)
16 1234567
17
18 YEAR
19

Moving Chart

e |If the chart needs to be placed in different position, then we can move the chart

wherever we want.

e To move the chart select the chart by clicking on it without leving the mouse button, drag

in the direction you want.

e The chart will move and then release it where you want.

Changing the Chart Size

e To change the chart size, select the chart by clicking on it.

e You will get eight small rectangular boxes around the chart.

o Now move the cursor to the border of the chart and the mouse pointer changes to

double headed arrow cursor.
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e Then press the left mouse button and drag.

e If you want to reduce the size, drag towards the centre of the chart, else in opposite

direction to increase the size of the chart.

Changing the Chart Type

e Select the chart
e Click the right mouse button

o From the right context menu select Chat type

A E C ] E —
% F kChart Area...
1 Rice Yield Analysis St SR Area
2 | Year Rice Yield (tonnes) | chartType.,
2 1998 546,858 .95 Source Data...
4 1999 895,?45.?? Chart Options. ..
] 2000 1,025,892 .62 Location...
B 2001 2548955 05 w
i 2002 5,895438.25 RICE YIELD ANALYSIS CHART |
d 2003 7,102 584 85 Chart Window
9 2004 0,983 529.25 12000000 8 o
1? = _ 10000000 DE:WC; Copy
T 8§ 8000000 B paste
m Y2 5000000 1 _ |
I3 = O 4000000 J L |mRice e
w
14 = = 2000000 . I I "E"nal Bring ko Fronk
13 * 0 '.I.I.I.I.I. flelc Send to Back
1 ? 12343567 Assign Macra,..
18 YEAR J
10 n |

e Select the required chart type from the chart type window.
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Chart Area

-

3

Chart Type
A E
1 Rice Yield Analysis Standard Types l Custom Types |
2 | Year Rice Yield (tonnes] Chart type: Chart sub-type:
a8 1998 548,858 895 == Bar -]
4 1998 205,745 77 | Line
& 2000 1,025 892 B2 @ Fie
B 2001 2548955 55 p— |[e= ‘f {Scatker)
7 2002 5,395 458.25 I
5 2003 7,102,584 B5 % o
g 2004 §AB35248 25 &) surface
10 = @ Eubble |
11 O vl |t Stock
12 " E % B Cvlinder j
13 > E Options
14 g [ Stacked Area, Displays the trend of the
= r contribution of each walue over time or
15 [ Defaulk Farmatting cakegories.
8
17 Press and Hold bo Yiew Sample |
18
19 | I @ Set as default chart oK | Cancel |
an
e Click OK.
o If the selected chart type is Area type then the chart will be as shown below:

A B i O E F
1 Rice Yield Analysis
2 Year Rice Yield (tonnes
4 19498 b4k 858 A5
4 18499 805,745 77
3] 2000 1,026 842 B2
4] 2001 2048000 00 u |
7 2002 5,892,438.25 RICE YIELD AMNALYSIS CHART
d 2003 T.102 584 RS
2| 2004 HBB35Y3.25 12000000 : :
1 S 10000000 " sty Rice

aw
12 o & 5000000 Yield {tonnes)
m == BO00000 + Rice Yield

. w 2 4000000 - DArlwnaﬁ slig Year
14 S " 2000000 - v
15 N
18 1 2 34 8 6 7
17
18 YEAR
19 n [ [ |
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LECTURE SCHEDULE 13

MSACCESS: Concept of Database- Units of database, creating database

Database
e A database is a collection of interrelated data that is organized so that it can easily be
accessed, managed and updated.
e A database-management system (DBMS) is a collection of interrelated data and a set of

programs to access those data.

Characteristics of Database

e Self-describing- a database gives description about itself.

Multiple users can access the same data.

o Data exists permanently

o Data security protects the data from unauthorized access with the help of the
passwords.

e Many software are used as Database Management Systems. Example: MS-Access,

ORACLE etc.
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Structure of Database Management System

Tsers f Programmers

b

Jueries f Programs

Zoftware to process

quElEs

b

Softwrare to access stored data

Stored Database

Tables

Lf daa

Tables contain data

Stored Database

The main components of tables are:

o Field

o Record

A field is the smallest data item stored in one particular format.

A record is one complete set of related field.

Example: Following is Student table in an University database

Student Name | ID STAM Mark AGR Mark PBG Mark
Adithi BSA-10-001 98 99 95
Bhargavi BSA-10-002 56 75 67
Natarajan BSA-10-003 86 70 75
Madhavan BSA-10-004 78 79 76
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e The columns in the table are fields or attributes. Fields store the smallest unit of data.

e The rows in the table are called tuple or record. The record is one complete set of

relation.

Database concepts

e Data is a known fact.

o Data may be name of a student or mark scored by a student or age of a student or dat of

birth of a student. Thus the type of the data varies, that if it is a name then it will contain

only any combination of the alphabets, if it a mark then it will be only a number, if it date

of birth then it will only be a date.

e The data types supported by the DBMS are :

o Numeric - numbers

0 Alphanumeric - letters and digits
o Date/Time - dates

o Logical- logical data

o Auto number - unique value

Numeric

¢ Numbers only (no letters) includes numbers with decimal points.

e Numeric field can contain:
0 Only the numeric characters of 0 to 9

0 The decimal point

Alphanumeric

e Alphabets (letter), symbols and numbers

¢ Alphanumeric data can be made up of the following characters:
0 Numbers0to9
0 Alphabets AtoZ, atoz

0 Special characters #,/,$, * etc.

Data/Time

e Used to specify the field contains date
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Logical

e Logical data type used to store Yes or No and True or False

Auto number

¢ A unique value generated for each record.

Components of database

e Tables - contains data

o Queries - selected information is displayed on the screen

¢ Reports - formatted printed information

e [Forms - screen created to add, modify, and delete records
Primary Key

e The primary key is a field in the table which uniquely identifies that particular record in
the table.

e The primary key cannot have a duplicate value in the table.

e Every table should have a primary key associated with it.

Tasks associated with the tables

Creating a table

0 Specifying field names, data types, field sizes

Adding records to the table

Modifying data in the table

Deleting records from the table

Creating relationship between tables
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Tasks associated with the queries

o Creating queries to obtain information
e Creating queries to update data

e Creating queries to update data

MS-Access

e MS-Access is a Relational Database Management System (RDBMS) developed by

Microsoft Corporation.
¢ It provides the software tools to organize the data in a flexible manner.

e It provides facilities to add, modify or delete data from the database, ask questions or
gueries about the data stored in the database and produce reports summarizing

selected contents.

Creating Database

e Click on Start button = Select All Programs - Click Microsoft Access

e The opening screen of the MS-Access will get displayed
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Microsoft Access

File  Edit Wew Insert Tools  Mindow  Help

Dexd®E S&E Y| &BR| -

Twpe a queskion For help

Open a file

4 % Mew File -

=X

-

= Files...

Mew

Blank Database

Blank Data Access Page
Project (Existing Data)
Project (Mews Daka)

Mew From existing File

5] Choose file...

Mew Ffrom template

General Templates. ..
Templakes on Microsoft. com

5 add Metwork Place. ..
@ Microsoft Access Help

e As we are going to create a new database, in the New File window click blank database.

¢ File New Database dialog box will get displayed asking us to choose the location of the
database and the name of the database. Enter the name of the database as crop.
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Save in:

a G.-'H

My Documenks

Favarites

File Mew Database

|=E.||- Local Disk {Z:)

jq:-v @ 9 EH - Todls~

I ACDFREELD
IE] Agress
EDncuments and Settings
I Inetpub

I off-xp

I ORANT

I Perl
I==3Program Files
Iy Pythonz4
I==spdbey

IhTC

[C WINDOWS

Filz name: |.;r.;.p

j Create |

Save as bype: |Miu:ru:usu:uft Arcess Databases

e Click Create button.

ﬂ Zancel

o Crop database is created and crop database window will get displayed as shown below:

Chjecks

= crop : Database (Access 2000 file format)

(7= open &€ Design 5 New

Tables

Queries

Forms

Pages

Macros

B OEEE G

Groups

o Choose create in Design view option.

R.eparts

Maodules

(3] Favorites

Create table by using wizard
Create table by entering data

=S
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o Default name of the table is Tablel will get displayed in the title bar of the Table window.

e Enter the field name under Field Name column.

o Data type can be selected with by clicking the down arrow key in the Data Type column

as shown below.

E Tahlel : Tabhle

Field Mame

Data Tvpe

Descripkion

B=1E

B | Crop Culkivated

General l Lookup ]
Field Size

Format

Input Mask.

Caption

Default Yalue
Walidation Rule
Walidation Text
Required

Allows Zero Length
Indexed

Unicode Compression
IME Mode

IME Sentence Mode

Text =

Mermo

Murmber

Date/ Time
CUrrency
Autolurmber
Yesfho

OLE Object
Hyperlink,
Lookup Wizard. ..

a0

Mo

Yes

Mo

Yes

Mo Control
Mone

Field Properties

The dakta tvpe determines
the kind of values that
users can store in the

field, Press F1 far help on

data types.,

e After choosing the data type of the field set the required field size in the field size tab.

e Enter the description of the field in the Description column.

¢ Following the above said instructions enter the other fields in the table.
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Data Tvpe

Descripkion

Crop_ID
Crop_iCulkivated
Zrop_Yield

Water Wastage
Drought_Resistence

General l Lookup ]

Field Size

Format

Input Mask

Caption

Default Yalue
Yalidation Rule
Walidation Text
Required

Allow Fero Length
Indexed

Unicode Compression
IME Mode

IME Sentence Mode

Text
Text
Murnber
Murnber
Text

Mo

Yes

Mo

Yes

Mo Conkrol
Mone

Identification number of the crop in the database
Marme of the crop culkivated

Yield of the crop in tonnes

Water wasted in gallons

Drought resistance remark,

Field Properties

The label For the Field
when used on a form, IF
wol don't enter a caption,
the field name is used as

the label, Press F1 For
help on captions.

e To set Crop_ID as the primary key of the table right click the field Crop_ID.

e From the right context menu choose Primary Key option.

Field Mame | DsataType | Description
[ #|Frop ID  —— —-—Toet Idenkification number of the crop in the dakaba
| | Crop_Culbrez T Primary Eﬂ:,'_l Mamee of the crop cukreated
|| Crop_Yield — . pr ¥ield of the crop in tonnes
| |Water_Wast r Waker wasbed in gallons
| |Crought_Re: Crought resisbance remark,

Insert Rows
Delate Rowes |
Build. ..

Froperties

Field Prooerties

o A small picture of a key appears next to Crop_ID.
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e Now the definition of the

table structure is complete.
Table Mame:

e To save the table click the [Crops_Detail

File menu and Save. Canicel

e In the Save As dialog box

specify the name of the

table.

¢ Close the table by clicking on File menu and Close option.

e The Crop_detail table is displayed in the ‘Tables’ tab as shown below:

e crop : Database (Access 2000 file format) |Z||E|[z|

= open 5 Design g Mew

Chjects

& kable in Design view

Tables Create kable by using wizard

i Create table by entering data

EEEETE]

Crops_Dekail
Forms

Reporks
Pages
Macros

Maodules

S NS E B R

Groups

(3] Favarites

Adding Records to the Table
¢ In the design view under the Crop database we have created the table Crop_Detail and

assigned Crop_ID as the primary key.
e To add the records right click the table Crop_Detail and select Open option.

o The datasheet view of the Crop_Detail table will get opened.
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B Crops_Detail : Table

Crop Cultivated| Crop Yield | Water Wastage | Drought Resistence
a

Record: Hl 1 ” 1k |H |H+E| af 1

e The field names are displayed as headings and a blank row is provided to enter data.

e Enter the data in the corresponding fields. When all the records are added the screen

will be as shown below:

B Crops_Detail : Table

Crop_Cultivated| Crop Yield | Water Wastage | Drought Resistence
CR-001 Ehendi 567 24536 Partial

CR-002 Paddy 1896 29623 Less

CR-003 Bajra 208 12658 Extermea

CR-004 Sesame 143 10467 Extreme

CR-005 aize 2876 27543 Mo

CR-00B (Sroundnut L 154589 Less

CR-007 Cowpes 1045 20567 Moderate

CR-005 Anhuriurm 2b45 24675 Less

CR-004 =orghum 437 12784 Maoderate

CHE-010 Tomato 950 k327 Moderate

1] a

Record: Hl L ” m k |H |H+E| af 10
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To Delete a Record from the table

e To remove the 5" record with Crop_ID CR-005 and Crop_name as aize right click on the

arrow (III) tabin front of the record and choose Dekete option as shown below:

B Crops_Detail : Table

Crop_Cultivated| Crop Yield

&(=]E3

Water VWastage |Drought Resistence

b |CR-005

Mew Record

Bhendi aG7
Paddy 1895
Bajra 289
Sesame 143

raundnut

Delete Record

R

Zut

copy

Row Height:, ..

nhurium
orghum
amato

Record: 14| 4 5 k| M Héln:nl‘ 10

24536 Partial
29623 Less
12658 Exterme
10467 Extreme
2radd Mo
15484 Less
20567 Moderate
24678 Less
12784 Moderate
4327 Moderate
a

e Access prompts the user for the final confirmation because the record once deleted

cannot be recalled back.

e Click on ‘Yes' if you are sure to delete it.
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B Crops_Detail : Table

Crop Cultivated| Crop_ Yield

Water Wastage |Drought Resistence

Bhendi
Paddy
Bajra
SESame
Groundnut

567
1856
289
143
B2
1045

Microsoft Access

24536 Partial
29623 Less
12658 Exterme
10467 Extremea
15489 Less
20567 Moderate

You are about to delete 1 record(s).

f ; h IF wou click Yes, wou won't be able to undo this Delete operation.
Are wou sure you wank to delete these records?

Record: Hl 4 || L |H |HE| af 9
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LECTURE SCHEDULE 14

Principles of Programming: Flow charts, illustrations through examples

Principles of Programming

e The program or set of programs in a computer that helps in processing the information is
called SOFTWARE.

e Software is a detailed writing of stepwise instructions for the computer to carry out the
particular task efficiently and properly.

e The art of writing software is called programming.

o Software is an essential part of a computer. Without the software the computer will

neither accept information nor give the desired result.

Algorithm
e A step-by-step procedure to solve the given problem is known as Algorithm.
o The essential properties of Algorithm are:

It should be simple

It should be clear with no ambiguity

It should lead to a unique solution of the problem.

O O O o

It should involve a finite number of steps to arrive at a solution.
o It should have the capability to handle some-unexpected situations.

o For example if a student wants to purchase a pen, he has to follow the following steps.

Action

%))
—
D
©

He has to get money from parents.

Come out of the House to cross the road

Check the vehicle movement for safe crossing.

When it is safe to cross the road, he crosses the road.

He gets into the shop.

Asks for a pen.

Selects a pen from the lot shown to him by the shopkeeper.

© N o o M W NP

Pays money to the shopkeeper.
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e These numbered steps are known as Algorithm.

Flow Chart

The graphical or visual representation of algorithm is called as flow chart.

o The flow charts are easier to understand the flow of the solution.

e Flow charts are drawn with the standard symbols accepted worldwide.

e Each standard flow chart symbol represents on action to be performed such as Start or

Stop, input operations Read or Write, decision making etc.

Standard Flow Chart Symbols

1. Terminal (Start or Stop Symbol)

2. Input / OUtpUt E

3. Processing
4, Flow Lines: These are arrow mark symbols used to T
connect two boxes and to indicate the direction of

data or processing flow.

5. Decision Box: This is a diamond shaped box, which
is used to indicate logical checking and gives l
decision after comparing between two or more

objects (Eg. Yes or No; True or False, =, >, <, etc.) False

l True
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6. Connector: This is a Circular-shaped symbol used to
connect different parts of flowchart. When the flow
chart is lengthy, it is split into different pages. Then
these connectors are used to connect between these

pages at the beginning and at the end of each page.

lllustrations through examples

1. Algorithm and flow chart to read the name and print the name.
Algorithm Flow Chart
Step 1 : Start

Step 2 : Read input name ( Start )
‘

Step 3 : Print name

Step 4 : Stop / Read Name /
]
/ Print Name /

Coor )
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2. Algorithm and flow chart to add two numbers.
Algorithm Flow Chart
Step 1 : Start

Step 2 : Input first number A
Step 3 : Input second number B S‘[EII"[
Step 4 : Add the two numbers and store it in l

total / Input A /
Step 5 : Print Total l
/ Input B /

Step 6 : Stop

Total= A+ B

'
/ Print Total /

G

3. Algorithm and a flow chart to calculate area of square.

Algorithm Flow Chart
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Step 1 : Start
Step 2 : Read value for a (side) ( Start )
Step 3 : [Compute] Area=A* A l‘

Step 4 : Output Area

Step 5 : Stop / Refd A /

Area=A* A
l
/ Print Area /
'
( Stop )

4. Algorithm and flow chart to find the average of three numbers.

Algorithm Flow Chart
Stepl : Start
Step 2 : Enter Three Numbers A, Band C < S‘[EII"[ )
Step 3 : Compute Average = (A+B+C)/3
¥

Step 4 : Print Average
Step 5 : Stop / Input A. B /

Average=(A+B+C)/3

v
/ Print Average /

G
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5. Algorithm and flow chart to find the largest of two numbers.

Algorithm
Stepl: Start

Step 2: Enter two numbers A and B

Step 3: Check if A is greater than B if yes go to Step 4 else go to Step 5
Step 4: Print A is greater than B

Step 5: Check if B is greater than A if yes go to Step 6 else go to Step 7
Step 6: Print B is greater than A

Step 7: Print Ais equal to B

Step 8: Stop
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"D
/ Inp:lrt A B /

Flow Chart

Print A is greater
than B

Print B is greater
than A

/Pr'mtAis equalmB/
( Stop )

6. Algorithm and a flow chart to find the factorial of a number.

Algorithm

Step 1: Start

Step 2: Read N

Step 3: [Initialize all counters] Set FACT=1,i=1

Step 4: Compute Fact = Fact * | Increment i

Step 5: Check if i < = N if true repeat step 4 if false go to step 6
Step 6: Print fact
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Step 7: Stop

Flow Chart

- C Start )
'

/ Read N -
|
i1

FACT =1

]

FACT =FACT * 1
1=1+1

Yes

e PrintlFACT /

Stop

Advantages of Flowchart

1. Conveys Better meaning

Since a flowchart is a pictorial representation of a program, it is easier for a programmer

to understand and explain the logic of the program to other programmers.
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2. Analyses the problem effectively

Flow chart helps the programmers to analyze the problem in detail by breaking the flow

chart into detailed parts.

3. Effective Coding

It is very easy for the programmers to write the program, because flow chart will give a

clear idea of the steps involved.

4. Systematic Debugging

Even after taking the full care in program design, some errors may remain in the
program because the programmer might have never thought of a particular case. Using

a flow chart can reduce this type of errors. It also enables easy detection of errors.

134 www.AgriMoon.Com



Introduction to Computer Applications

LECTURE SCHEDULE 14

Internet: World Wide Web (WWW), Concepts

Internet

» Network of interconnected computers around the world.

» A network of computer networks which operates world-wide using a common set of
communications protocols.

* a computer network consisting of a worldwide network of computer networks that use

the TCP/IP network protocols to facilitate data transmission and exchange.

* Visualization of the various routes through a portion of the Internet:
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What do we need to get connected to internet?

* Getting on the Internet requires:

— Computer
— Modem
— Telephone Line

— Internet Service Provider (ISP)

— Communication Software

Modem and Telephone Line

¢ Modem is a communications device
that allows us to communicate with

another computer through telephone

lines.

¢ Modem is abbreviation of

modulator/demodulator.

Internet Service Provider (ISP)

Telephone services, such as
— ISDN,
— 56K leased lines, and
— T-1 connections
offer connections to the Internet at

considerably  faster connection

speeds.

* An Internet Service Provider (ISP) is a company that allow you to use their internet

connection for a price.

* When you register with an ISP the followings are given:

— Username
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* A unique name that identifies you.
— Password

» A secret code that prevents other people from using your account.

Some Popular Internet Service Providers
e AT&T WorldNet

* Microsoft Network

* America Online
* InIndia:
— VSNL (Videsh Sanchar Nigam Limited
— MTNL (Mahanagar Telecom Nigam Limited)
— BSNL (Bharat Sanchar Nigam Limited)
— Satyam Onlile

Communication Software

+ Computer needs communicate
* on software to allow you to get connected to, and interact with, the Internet.
+ Communication software is of two types:

— Software that Helps Establish Basic Internet Connectivity

— Software that helps to browse, access e-malil etc.

World Wide Web

"The World Wide Web is the universe of network-accessible

information, an embodiment of human knowledge."
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e Tim Berners-Lee, a scientist at CERN (The European
Organization for Nuclear Research (Erench: Organisation
Européenne pour la Recherche Nucléaire), invented the
World Wide Web (WWW) in 1989.

e The Web was originally conceived and developed to meet

the demand for automatic information sharing between

scientists working in different universities and institutes all

over the world.

e The basic idea of the WWW was to merge the technologies of personal computers,
computer networking and hypertext into a powerful and easy to use global information
system.

e The World Wide Web, abbreviated as WWW and commonly known as The Web, is a
system of interlinked hypertext documents contained on the Internet.

¢ With a web browser, one can view web pages that may contain text, images, videos, and

other multimedia and navigate between them by using hyperlinks.

Hypertext
* Hypertext is text displayed on a computer or other electronic device with references
(hyperlinks) to other text that the reader can immediately access, usually by a mouse
click or keypress sequence.
« Apart from running text, hypertext may contain tables, images and other presentational
devices. Hypertext is the underlying concept defining the structure of the World Wide
Web, making it an easy-to-use and flexible format to share information over the Internet.

Web Browser

» A web browser is a software application for retrieving, presenting, and traversing
information resources on the World Wide Web. An information resource is identified by a
Uniform Resource Locator (URL) and may be a web page, image, video, or other piece
of content.

» Example of Web Browser:

0 Mosaic
0 Internet Explorer

0 Netscape Navigator
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o Mozilla Firefox

Web Page and Websites

* W3 contains several millions of pages of information. Each of these pages is called a Web
Page.

* A webpage or web page is a document or resource of information that is suitable for the
World Wide Web and can be accessed through a web browser and displayed on a computer
screen.

* A web page can contain text, pictures, sound, animation and video.

« A group of related web pages that are linked together form a Web Site.

» The first page of a web site is called the Home Page.

e The Home Page shown below is the Home Page of the official website of Tail Nadu

Agriculture University.
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nau nome - Micl neer orer

Fle Edit WView Favorites Tools Help

eBack M e M @ @ @ pSearch *Favorit&s @ @' t’:} E D @ ﬁ f&
Address |@ http:/fuww, tnau,ac.in/ &

Tamilnadu Agricultural University

transforming the lives of farmers _.

Tnau Home Academics Admizzions Student Rezources Technologies QOutreach News & Events

e

1
- Dynamic Market |nf§Mati

; I“ "y

W2
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Universal Resource Locator

» Each web page has a unique address called I need to connect to a site

Universal Resource Locator (URL). The URL is htp://www.yahoo .com

» Contains unique information about the server
and the path on the server to find and retrieve

the information

Example: http://www.usd.edul/trio/tut/start/url.html

http:// protocol — rules through which transmission takes place over the

internet.

www.usd.edu/ | server name - computer domain name

trio/tut/start/ pathname to the directory you are requesting

url.html filename you are requesting

Search Engine

» A web search engine is designed to search for information on the World Wide Web. The
search results are usually presented in a list of results and are commonly called hits.

* Few examples of web search engines are:

Google

Google.com

Ask.com
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Yahoo.com Y HO O

INDIA

blng

3 SEARCH ENGINES IN ONE

= shopzilla

Bing.com

Shopzilla.com
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LECTURE SCHEDULE 16

Web Browsing and Electronic Mail

Web browsing

Browse means reading superficially or at random.

web browsing.

information resources on the World Wide Web.

Understand the browsers

Reading information contained in the WebPages on the Internet using browsers is called

A web browser is a software application for retrieving, presenting, and traversing

& Blank Page-Windo\wilnternet Explorer GO Button E@M
U\\J |§, www.inwes.cuﬁ\ }"‘*} ‘ )klll'.ivs Search P -
File . Edit View Favorites %ﬂl{ Help
w >5"( {& Blank Page |_| ‘E}\' B ~ s v [2hPage v [ Tools » 25
Stop
Title Bar Address Button
Menu Bar
Bar Tool Bar
Search Bar
Blank Page
f/{f
Status Bar
i € Internet | Protected Mode: Off #100% -
143 www.AgriMoon.Com



Introduction to Computer Applications

e |n the address bar of the browser enter the address of the website or enter the address

of the any search engine.
o If the address entered is a website then the corresponding webpage will get displayed.

o If the address entered is of a search engine (For example Google) then the webpage of

the corresponding search engine will get displayed as shown below:

‘@ Google - Microsoft Internet Explorer B‘
Fle Edit View Favorites Tools Help ’f
€ ) \ﬂ \ELI _I\J P ) Search ‘i'\'( Favorites @3 < “‘i’i —3 _] %’ﬂ ﬂ “3
Address @http:..".."','-,l','-,l','-_l,google,co,in.." [V] Go Links **
Web |mages Maps Mews Orkut Books Gmail more - iGoogle | Search settings | Sign in

CO O em
g India

Advanced Search

Langusge Tools

Google Search ] l I'm Feeling Lucky ]

Search: @ the web O pages from India

0 Make Google my homepage

Google.co.in offered in: Hindi Bengali Telugu Marathi Tamil Gujarati Kannada Malayalam Punjabi

Advertising Programs - About Google - Go to Geogle com

@2010 - Privacy

@1 B Internet

¢ In the search tab enter the information about your search. For example if you want to

browse about computers enter the computers in the search tab.

e Then click Search tab.
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e A set of pages with the links to the webpages which contain information about computer

as shown below:

|@ Computer - Google Search - Microsoft Internet Explorer

File Edit View Favorites Tools Help

eBack M |ﬂ @ _h /:\J Search ‘-F/n:‘( Favorites €‘} [1\" ; — _J g;‘_, ﬂ ﬁ

u@:@

Address @ http:{fwww.google.co.infsearch?hl=en&source =hp&g=Computer &meta =8&aq=faagi=g 10&aql=&og=~gs_rfai=

M Go Links **

Web Images Maps MNews Orkut Books Gmail more «

Google Computer hancea Sescn

Search: @ the web O pages from India

Web History | Search settings | Sign in

www_Intel_.com/TurboBoost Purchase an Intel® Core™ i5 Desktop & Win a Trip to the Edge of Space!

Laptop Computers

WWW_CIDZONe.com Laptop Computers: visit the network source for [T Leaders

Related searches: computer pictures definition of computer  basic computer

Computer - Wikipedia, the free encyclopedia

A computer is a programmable machine that receives input. stores and manipulates data
and provides output in a useful format. ...

History of computing - Stored program architecture - Function
en.wikipedia.org/wiki/‘Computer - Cached - Similar

Computer science - Wikipedia, the free encyclopedia

Computer science or computing science (sometimes abbreviated C3) is the study of the
theoretical foundations of information and computation. ...
en.wikipedia_.org/wiki/‘Computer_science - 15 hours ago - Cached - Similar

[ Show more results from en wikipedia org

The |IEEE Computer Society

The [EEE Computer Society serves computing professionals’ information needs with
technical publications. conferences. books. proceedings. cerifications. ...
www_computer_org/ - Cached - Similar

Computer Magazine

Computer magazine covers all aspects of computer science. For more than 40 years.

Web @ Show options Results 1 - 10 of about 646,000,000 for Computer [definition]. {0.26 seconds)
Desktop Computers Sponsored Links | Sponsared Links L

Personal Computer

Build your Desktop Cnline Mow!
Powered by Intel® Core™ i3
Dell.co.infHome/Desktops

Samsung Awesome Two-some
Offer. Now Get Metro 3310 or TATA
Photon at Special rate with Laptops
www.Samsung.com/in

See your ad here »

@ Done

0 Internet

¢ Clicking the links desired by you will be taking you to those webpages.

145

www.AgriMoon.Com



Introduction to Computer Applications

Return to a Web Page That You Just Visited

To return to the last page you visited, click the Back button on the browser toolbar.

Click the Forward button to retrace your steps and return to pages you visited before you
clicked the Back button.

To see one of the last nine pages you visited in this session, click the tiny black arrow to the

right of the Back or Forward button, and then click the page you want from the list.

A Microsoft Streets & Trips 2003 - Microsof
File Edit Miew Favarites Tools  Help

o . © . I_’E'] L@
Back, Faorward Skop Refresh
Address @ Rt Microsoft %&55

. Microsaft Morey
== « Microsoft Money 2003 Home
- &

; r 3] History Ctrl+H

Forward button on the Internet Explorer 6 toolbar

Find a Web Page That You Visited Today or a Few Weeks Ago

The browsers automatically records Web pages you've visited both today and in the past. It
organizes them in folders on the History bar by the day you visited. Within each day, it
organizes the Web sites alphabetically in folders, putting each page visited on that site in that

folder. Here's how to find pages in the History list:

1. On the Internet Explorer 6 toolbar, click the History button.

Internet Explorer 6 opens the History bar on the left side of the screen.

\I-I I_,-'-' @ e} - [
Gy F "4

wiorites Media Histary Mai Ptir:

History button on the Internet Explorer 6 toolbar

2. In the History bar, click the time period you want to search. For example, you may want to
see all the sites you visited today. (Marked (2) as in the figure shown in Step 4.)

3. Click the Web site folder to open the list of pages, and then click the link to the page to
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display the Web page itself. (Marked (3) as in the figure shown in Step 4.)
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History bar showing Web pages sorted by time period

5.  When you've finished using the History bar, click the Close button.

Electronic Mail

e Electronic mail, most commonly abbreviated email or e-mail, is a method of exchanging
digital messages.

e E-mail systems are based on a store-and-forward model in which e-mail server
computer systems accept, forward, deliver and store messages on behalf of users, who

only need to connect to the e-mail infrastructure, typically an e-mail server.
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Creating Email

The users can have email account in any one of the email services such as gmail, yahoomail,
rediffmail etc.

To create an email account in any one these email services the user need to enter the address
of the service in the browser first.

The service will prompt the user to know whether a new user or not.

If you are a new user then the service will guide step by step to create your own email id.

Email Addresses

Email addresses are made up of at least two parts. One part is the name of a mail domain that
will ultimately translate to either the recipient's host or some host that accepts mail on behalf of
the recipient. The other part is some form of unique user identification. Most e-mail addresses
are set up like this: it is your username, then an @ (‘at’) symbol, and then a domain name

(something .com, .net, or .org in most cases).
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Using Email

Using e-mail is rather straightforward. Once you have an account set up, select the option that
says something like "new e-mail message" or "create a new message". The service will prompt

with three boxes (called fields):

e To:
e Subject:
e Body

e Attachment

To field: In the To field type the complete e-mail address of the person who will receive the e-

mail.

Subject and Body fields: Type anything you want in the subject and body fields, but remember

the length of the subject is limited.

Attachments: Click the Attach a file or Attachment link to add files to the message.

Sending the message

Once filling all the required fields and attaching files to the message click Send button to send

the message.

You can forward (make a copy) of a message you receive from someone (if you have their

permission if necessary) and mail it to someone else with the forward option.
CC and BCC

CC stands for carbon copy. If you want to send a message to multiple people, add the extra

people in the CC: field (usually you separate their e-mail addresses by commas).

BCC stands for blind carbon copy. BCC works just like a carbon copy, except the e-mail
addresses you type in BCC do not show up to the other recipients. (Example: You send a
message To: Mary and BCC: Joey. Joey will see Mary's e-mail address, but Mary won't see

Joey's e-mail address because you "blinded" it by putting it in the BCC field.)
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CAUTION: You can also get viruses by downloading executable files (usually .com and .exe on

Windows computers) from web sites. Don't download or run executable files from web sites you

don't trust.
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